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********************************************************************** 
Getting Started 
 
    Welcome to the AMT Image Capture Engine.  This first chapter tells you what all new users want to know, 
how to prepare the scope and camera and start taking pictures. 
The first four pages are about what you do before before any imaging, and the other three describe taking 
live and final images, and turning the camera off.  
 
    Contents 
 
    Retract the Phosphor 
    TEM Setup 
    Starting the Camera 
    Background Collection Procedure 
    Live Image 
    Final Image 
    Aborting Imaging and Closing AMT 
 

********************************************************************** 
 
Retract the Phosphor When  Starting or Finishing 
 
If there is a sidemounted camera, make sure that the phosphor is not in the beam.  The phosphor can be 
damaged by an overly concentrated electron beam. 
 
A previous user may have forgotten to remove the phosphor from the beam path.  
 

Align the TEM  
 
1) Align TEM and center beam.  
 
Note: It is easier to align the microscope using the standard TEM viewing screen and local alignment 
procedures.  
 
2) On side mounted systems, sure that the phosphor is retracted so that the beam is visible! Camera 
operation is easiest when the “current axis” is aligned and the intensity remains centered as magnification 
changes.  
 
3) If the TEM supports "Brightness" “Intensity" Zoom, use it. The camera typically operates at intensities 
equivalent to about 2 sec of film exposure. 
 
4) Spread the beam with the condenser (C2) control (clockwise) until the film exposure meter read at least 2 
seconds. Another method is to just spread the beam until it is kind of dark. The camera is pretty sensitive. 

 
Starting the Camera  
 
Camera Power On  
The power switch on the camera control box needs to be turned before starting the AMT Image Capture 
Engine.  Most labs leave the camera power on all the time, except possibly for weekends or vacations. 
Turning the camera power off for 60 seconds is also one of the first things to try if there's image problems. 
 
Get a Beam  
A previous user may have forgotten to remove the phosphor from the beam path. The phosphor can be 
damaged by an overly concentrated electron beam.  It is good practice to spread the beam to ~2 sec 
exposure  before inserting the phosphor spread the beam.  
 
Launch the AMT program  
At this point, if the camera program is not open on the AMT computer, open it by clicking the AMT Icon in 
the Start menu. 
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Background Collection  
 
Background correction compensates for inhomogeneities in the beam and phosphor and any other optical 
imperfections.  
 
Image quality critically depends on having a good background image.  We recommend that background 
images be collected each day or whenever there is a change in the gun high tension or  mechanical drift.  

1. View the beam on the TEM viewing screen. For side mount be sure that the phosphor is retracted. 
2. Pull out specimen rod or find empty position or hole in the specimen. 
3. Set the magnification in the mid-range for planned operation. Spread the beam with the condenser 

(C2)  control for 2 sec on the film exposure meter. The 2 second value is for a typical setup. Use 
higher or lower values if your camera is adjusted differently. 

4. For side mounts insert the phosphor. (For bottom mounts lift the viewing screen.) 
5. Select the Menu Item "Background - >Acquire Background". 
 

 
 

6. Adjust the second condenser (i.e. the TEM Intensity or Brightness knob) so that the histogram [red 
line in box] is approximately centered in the "box". When this is correct, click on the red command 
button. 

7. You will get a chance to cancel. If you proceed, it will take a minute or so for the backgrounds for 
the various modes to be acquired. WAIT until the "Click Live Imaging" button is re-enabled (gray 
letters return to black). 

8. You are now ready to collect images. 
  
   

 

 

 

Live Viewing  
 
For Side Mount Systems 
 
Flip the phosphor retractor switch toward the column on retracting mechanism. (This is automatic on 
H7500/H7600.)  Or  
turn the wheel counter-clockwise to the end position for manual system prior to 2001. 
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For Bottom Mount Systems 
 
Lift TEM viewing screen (This is  automatic  for systems with TEM communication.) 
 

  
 
 

 
1) The Survey radio button is normally selected for full images at fast viewing rates. 
 
2) Click on command button “Click for Live Image"  Adjust the brightness of the electron beam ( the TEM!) 
to center the histogram's peak.  The verticle green line on the right hand side should also be visible and at 
least slightly away from the right side of the white box.  
 

 
 
3) Clicking Speed Live, to make it Quality Live, averages frames in live imaging to reduce beam noise.  The 
tradeoff is that the camera will be a little bit slower. 
 
--  For faster imaging select Speed Live.  
--  To reduce live noise chose Quality Live.  The Quality setting has a slower update rate.  This button has 
no effect on the final image. You can fine focus using the Focus button, which enlarges the center region of 
the image.  
 
4) Focus Mode is an optional focusing tool. It zooms in on the image and removes binning, so you see more 
of the full resolution. 
 
5) Note: Starting in version 5.4 there is a 4 by 4 mode option (with 4x4 binning) for most cameras. This 
setting runs very fast with near TV rates, but live image quality is less than survey mode.  
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Acquiring a Final Image for Saving  
 
After the “Live” image is focused and illuminated properly, then “Click for Final Image” for an image that can 
be saved (i.e. a Final Image). This will take approximately 15 seconds. The camera is usually set to take a 
number of final images and average them to reduce noise. You can adjust how many are averaged (See 
"Camera Settings And Control Window"). 
 

 

 

 

Aborting Imaging and Closing AMT Software  
  
    The fastest way to stop imaging is to click the "Abort" button under the Live/Final Imaging button. 
 

 
 
 
Aborting just turns off camera imaging, it doesn't collect a final image. 
 
To close AMT Software click on the menu items: 
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********************************************************************** 
Saving Images and Cases  
 
    Now that you're experienced taking pictures, you probably want to save them.  There's two methods in 
AMT for saving images.  The first is the familiar "File -> Save As" method.  For a more efficient method of 
collecting and saving multiple images quickly use the Case Study protocol. 
 
Contents 
 
    Microscope Information Window 
    Saving via "File Save As" 
    Default "Save To" Path 
    Case Study Protocol 
          Creating A Case 
          Saving To A Case 
          Case Display Options 
 

********************************************************************** 
 

Microscope Information Window  
 
Whichever method you choose for saving images, before saving you will encounter the Microscope 
Information window.  This is a collection of information which will be stored with your image.  The items you 
check will be displayed at the bottom of the image when it's opened in an image processor and in a print. A 
saved image's information can also be displayed in the AMT program by clicking (on the upper menu) 
"Display" and then "Show Current Caption On Screen". 

 
If your scope has 
communications, the 
Magnification, and possibly 
the Voltage, stage X and Y 
and Ti lt, will be automatically 
entered when you collect your 
final image.  For scopes 
without communications you 
need to type in the correct 
values.  
There is room for two optional 
Caption lines.  The main 
reason for the Keywords is that 
all this information is saved to 
two databases, besides being 
saved with the image.   You 
can use Keywords to facilitate 
searches for images or data.  
If you check the Keywords 
they will also be displayed in 
a processor, but not on 
separate lines. The "Facil ity" 
name is set in "Utilities-
>Special Options" on AMT's 
upper menu. 
 
If you're using the Case Study 
protocol the window will 
display a path and a 
filename, which is the case 
name plus an auto sequenced 
number. 
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Near the top of the window you choose whether you would like the saved image to display the "Print Mag" 
(e.g. "Print Mag:  19600x @ 7.0 in") or Pixel Size (e.g. "Cal : 0.005 microns/pix") or neither.  "Printer Units" 
sets the print width, using either inches or millimeters. This number is used by whatever image processor you 
print from.  
(Note: The "Print Mag" displayed under the image is calculated for a print of the width you set here. If, when 
printing, you click "Fit to available space", the Print Mag displayed on the printed image will be wrong. If 
you want a wider print, it is best to set it wider here.) 
 

 

 

 The first item in menu at the top of the window, "KeyboardCommands" displays two keyboard shortcuts 
when clicked. The "SwitchMode" item changes the "Imaging Mode" from imaging to diffraction, which 
changes "Magnification" to "Cam Length". "Add File Options" allows one to add a suffix to a filename (case 
study only) or create a text file with all the image's information (Not available in Case Study). 
 

 

 

When the information in the window is complete, click the "Save With Caption".  This saves all the 
information in the window.  For a shortcut back to live imaging, use the right button on the mouse for this 
cl ick.  This will automatically restart live imaging after the image is saved. 
 
 
 

Saving via "File -> Save As"  
 
     Users with Windows computer experience are famil iar with saving files this way.  "File"  is the leftmost 
item in the top menu.  When you click "Save As" the Microsope Information Window discussed above will 
appear.  After you click "Save With Caption" in that window the following window will appear: 
 

 

 

 
    Here you are asked to 
choose a location folder for 
the image, and to give the 
File a name.  You can also 
choose what type of file to 
save.  The default type is a 
Tiff image file. 
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Setting the Default Image Path  
 
 Whether you are saving using "File -> Save As" or are creating a case, you are presented with a default 
saving folder. The usual default folder is C:\Images (the Images folder on the C drive).  But if you frequently 
save to a different location, say to a network drive, you can streamline the process by making that the default 
saving folder. 
 
 To change the default path, before you start saving an image, go to the "File -> Preferences->Image Save 
Options->Set Default Image Path". 
 

 

 

 
    After this selection you will get the following window for typing in the default path: 
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********************************************************************** 
Saving via the Case Study Protocol  
 
      When you save an image to a Case it is automatically given a file name and a location, so it's the fastest 
way to save multiple images of a specimen.  If you right click the save button in the Microscope Information 
Window, Live imaging is automatically restarted, saving a few more seconds. 
 
    Contents 
 
    Creating A Case 
    Saving To A Case 
    Case Display Options 
 

********************************************************************** 
 
Creating a Case  

 
 
      The first step in using Case Study is to create a 
Case.  To do this go on the menu to "File -> Case 
Study".  
 
 
 
 
 After this selection the "Case Study Control" window 
will appear. It has a number of options for choosing, 
managing and displaying cases. Here we click the 
"Create New Case" button. 
 
 
 
 
 

 
 
 The "Create New Case" Window is where 
you set up the new case by choosing a case 
name, a file type and a location. The 
filename of images saved to a case will be 
the case name plus an automatically 
incremented number.   
 
 
 

 

The"ChangeFileSeparator" menu item give 
you the option of choosing what character 
separates the case name from the number. 
The default separator is an underscore  

 

 
 
 
 
 
. 
 
 
 



 13 

 
 
 
 
 
 
The normal file format is 8 Bit 
TIF. TIF images are "lossless" and 
are therefore the most stable. 
Eight bits is a big enough file for 
most purposes. A person might 
save 16 bit images if they were 
planning to do quantitative 
analysis (such as gray level 
comparisons or Fourier Analysis) 
of the final images after they're 
saved. There's an option to also 
save the images as JPEGs, which 
are smaller and therefore easier 
to send by email.   
 After you've entered a name for 
the case, click "Accept New 
Case" and the window will c lose. 
 
JPEG quality (%) is set in the 
main AMT window's 
"Preferences". 
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  Saving to a Case  
  
After you've collected a Final Image to save, click on the Case Study Icon (the 
File Cabinet), at the bottom of the left toolbar. 
 
 If you're in a case, for instance if you've just created a case, the Microscope 
Information Window, described next, will appear.  If you're not in a case a list of 
your active cases will appear for you to choose from. 
 

          
 
 
       Select one of the cases and click "Continue Selected Case".   The window will close.  Now you're in a 
case, but the image is not yet saved, so click on the File Cabinet Icon again to save. 
    Once you're in a case and click the File Cabinet, the Microscope Information Window, described above, 
will appear.  The image now automatically has a File Name, which is the Case Name plus an automatically 
sequenced number. 
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   You don't have to type anything in 
(except the Voltage and Mag if your TEM 
doesn't have communications).  You 
have the option however of appending 
the filename with a suffix, to facil itate 
finding the file in Windows. To do that 
cl ick "Add File Options" in the upper 
menu and then click "Add Suffix to 
Filename" 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
    When you're in a case the Case Study Icon (File Cabinet) will display the number of the next image to be 
saved there. 
 
 
 
 
 

 

 

 
 
Case Display Options  
  
      The Case study control window allows you to choose how the cases are ordered in the active case list - 
by date or alphabetically. 
 

 
 
 
 
 
 
    Clicking "Manage Case Files" will 
bring up the Case Archive Manager. 
Moving a case into archive does not 
move any images, it just takes the 
case out of your active case list to 
make it shorter. A case can be 
restored to the list just as easily. 
 
           
 
 
  

 
 



 16 

The Case Archive Manager Window 
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********************************************************************** 
Camera Settings and Control Window  
 
Your system has a multi-mode camera: So it is possible to adjust gain, exposure, binning conditions and 
record integrations. During installation a general purpose set of default conditions are set up. However, to 
optimize results under a variety of conditions, other settings are often needed. This section describes how to 
make changes to the camera and save them for use later on. 
 
    Contents 
 
    Set/Save 
    Recall 
    Sample Region 
    Exposure Times and Gains 
    Thresholds and Tails 
 

********************************************************************** 
 
Set/Save  
 

The "Set/Save" button at the lower right of 
you AMT display window opens the 
"Camera Settings Control" window.  This 
window is where most of the parameters of 
your camera are set. You can experiment 
with parameters without changing 
anything permanently if, after you change 
a parameter, you click  "Apply For Now 
Only"  to close the window.  If you find 
some settings you want to save 
permanently click on "Apply And Save 
Conditions To File".  If saving 
permanently you can give the settings a 
new name, and create as many sets of 
settings as you like. Changing the default 
conditions requires the password. 
 
 
Among the items controlled here are 
Exposures times (in mill iseconds), gains, 
record integrations, live frame averaging 
(Quality Setting), Autogain Sample 
Region, contrast settings (Thresholds and 
Tails) and Display Size.  

 

Exposure and Gain Control The exposure 
time (given in mill iseconds) and gain 
settings are analogous to exposure time 
and film sensitivity on a film camera. They 
control the speed and sensitivity of your 
camera. For more on this subject, 
inc luding balanc ing sensitivities between 
modes, see the page "Exposure Times 
and Gains"  

Record Integrations and Quality 
Settings These are similar operations where multiple frames are averaged together to improve signal 
quality.  The Quality setting work on the live image and the Record Integrations settings apply to Final 
images only.  Drifting Specimens:  If specimen drift is a problem, try lessening the Record Integrations. 
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Contrast Control The AutoGain function manages camera's contrast and uses it in the grayscales where you 
actually have sample. It uses the Black and White Thresholds to determine the contrast window.  Increasing 
the Thresholds can make the image more contrasty. Then Tails are added to each side of the windows.  
Tails use is more subtle, but they have an effect opposing that of Thresholds (See also Grayscale 
Manipulation.) 

Sample Region The Autogain's contrast control sets its range (the width between the vertical green lines on 
the histogram) by sampling a rectangle within the image. Its size is determined by the Sample Region 
setting. The default setting is usually 95%.  If white or black features, such as grid bars, on the periphery of 
your image, are from "hogging" the contrast, choose a smaller sample region, say 40%. The Autogain will 
then set itself looking only at the center 40% of the image, and so will ignore the periphery for setting 
contrast.  It is helpful to use a non-zero value of the Tails when the sample region is less than 100%. 

Auto-Sharpen Level  If you do sharpen images, AMT sharpening is probably better than doing it in an 
image processor, because it is native. You can choose sharpening levels of 1, 2 or 3. 

Apply For Now Only This applies the changes until the program is restarted, or until the user Recalls a set of 
settings.  It does not permanently change any parameters. 

Save and Apply This saves the changes you have made in this window to be loaded later. You can create 
settings with a new name or overwrite one of the standard ones. The Default Settings are password protected. 
Each set of settings has its own background and darkfield. If you use settings other than the default ones, you 
need to acquire a background while in them.   Creating settings with new exposure and gain values also 
requires acquiring  a new darkfield.  

 
Recall 
 

 
 
 
The Recall button is right next to the Set/Save one.  When you click it 
you will be given a menu of the stored configurations of settings, each of 
which have been created using the Set/Save button. 
 
 
 
 

 
The Default Settings are what your program opens with, and 
they're the ones you use most of the time.  The MediumMag 
and HighMag have more sensitivity, but are a little slower 
and noisier. Recall these settings when you don't have 
enough light (beam) for normal imaging in the default 
settings.  They can also be used at low mags if you have an 
especially sensitive sample you want to protect.  The more 
sensitive settings usually have the number Record 
Integrations set to one,  because stage drift is more of a 
problem at higher mags.  If your sample is not moving you 
can bump up the Integrations to reduce noise. 
The LowMagSettings have less sensitive settings in case 
they're needed for low mags.  On many  systems the default 
settings are fast enough for low mag work, so the 
LowMagSettings have the same exposures and gains.  The 
LowMagSettings make it possible to store a separate 
background for low mag work.  In some scopes the shape of 
the beam changes a lot between say 1.2KX and 6KX, and 
they find themselves taking new backgrounds when they 
navigate between these mags.  They find that having a 
separate stored background for low mag saves them time. 
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Each set of settings has it's own darkfield and background.  When you take 
your daily background it will be in the Default Settings.  If you use other 
settings they will need to have the background refreshed also.  (The 
darkfields are good for a year or two.) 
 
 
 
The set of settings you're using is displayed on the main user display, 
above the Set/Save and Recall buttons. 
 

 
  
Sample Region  
 

The "Sample Region" is the area which the AutoGain samples 
to set the contrast parameters. Pixels in this region are the 
make up the red graph in the histogram display. Normally this 
subregion is set between 80% and 95% the field-of-view as 
specified in the Camera Setting Control Window. The user 
can select values ranging up to 100%. This subregion is 
centered in the field of view. 
 
 
 
A sample region which is centered allows image contrast 
calculations to ignore extreme values of light or dark at the 
edges of the image. If light or dark extremes, such as a grid 
bar, are entering into the sample region from outside it, and 
making the contrast washed out, you can eliminate its impact 
on contrast by choosing a smaller Sample Region.  
 
Small window sizes tend to make harsher contrast, probably 
because of reduced statistics. Empirically, we find that 
increasing tails or using gamma helps. 

 
 
 

Exposure Times and Gains  
 
Exposure time and gain in a CCD camera are analogous to exposure time and film sensitivity in a film 
camera. They set the speed and sensitivity of your camera. The three live camera modes and the final 
(record) image mode, each has its own settings for exposure time and gain. Open them with the "Set/Save" 
button. 

Speed vs Sensitivity 
Speed and sensitivity are 
opposing ideals. A faster 
camera needs more beam 
intensity. Usually your default 
settings are set up to be fast, to 
facil itate scanning and 
focusing, but sensitive enough 
to cover your usual mag range 
without having the beam so 
focused that the edges are 
dark. For higher mags, or for 
very sensitive samples, 
MediumMagSettings and 
HighMagSettings are 
provided. They provide more 
sensitivity but run slower, and 
they may see a little more 
noise. LowMagSettings 
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usually have lower sensitivity (more speed) than your Default settings to facilitate a brighter beam at low 
mag. Sometimes LowMagSettings with the same sensitivity as the DefaultSettings are created which serve as 
a place to store a separate background for low mag. 
 
Balancing Sensitivities 
The three live modes and the final image mode need to have their sensitivities "balanced" so that your light 
level remains constant as you switch modes or go from live to final imaging. The sensitivities for your 
Default, Low, Medium and High Mag settings have been balanced by the installer. Balancing by the user 
might be needed if new settings are created, or the check balancing on the normal settings. A quick but 
imperfect, way to balance exposures and gains is with the "Balance Camera Exposures" button which is to 
the right of the exposure and gain values. This accepts the exposure time and gain of the Survey mode and 
adjusts those of the other modes to match it. For values close to the Default and MediumMag settings this 
method gives a pretty good approximation. For very fast or slow settings, or for precision balanc ing, one 
needs to use manual balanc ing. 
 
More Sensitive Settings 
To create a setting with more sensitivity start with the Focus mode, since that mode usually limits sensitivity. 
Using the current most sensitive settings, in focus mode, put the histogram to the left of center, say at 25% of 
the width of the box. 

 
 
 
Then bump up the focus mode exposures and gain, click "Apply For Now 
Only", return to live imaging and see where the histogram is. If its near the 
center you're ready to do manual balancing, using focus mode as the standard. 
If you want super sensitive settings, and don't need to use focus mode during 
imaging, you can ignore focus mode and use Survey mode as you standard. 
If you are creating Default settings for a new camera setup, a Focus mode with 
Exposures of 150ms and a Gain of 2 (sidemount) or 3 (bottom mount) is usually 
a good standard to start with. 
 

Less Sensitive Settings 
Be careful not to set sensitivity so low that you burn the phosphor. If Survey Exposures gets below 45, check 
the beam with the camera out to make sure it is spread out past the TEM viewing screen, and that the 
condenser aperture is in place. 

 

Manual Balancing 
 After you have set a standard (one mode with the correct sensitivity for the new settings), the next step is to 

set the Black Threshold and White Threshold to zero to facil itate balancing. This keeps the 
AutoGain function from interfering with the histogram display. Don't change the Tails. 

 
 

 
  
 Take your sample is out and turn background 

corrections off.  
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  Using whichever live mode is your reference point (standard), put the histogram peak in the center of the 
display box, maybe under the "O" in "Off". 

  
  
Now switch to the other live imaging modes and record mode (Final 
Image). Make a note for each mode of whether the histogram is higher, 
lower or about the same as where it is in your reference mode. 
  
  

  
  
  
  
  
 Then cl ick Set/Save to go back to the camera control window and there make adjustments to the 

exposures and gains of your non-reference modes to get their histograms nearer to that of the 
reference mode. You can type in new values for the Exposures and Gains. The Gains can be 
changed in increments as small as one tenth, using a decimal point. It is usually best to limit 
"Record" exposure time to about 1 second (1000ms) and use the Gain to make increases after that. 

 After you adjustments click "Apply For Now Only" and repeat steps 3 through 6. When the histogram 
moves very little as you switch between modes set the Thresholds back to 10 and then click "Apply 
and Save Conditions to File". The settings can be saved with a new name or some current settings 
can be overwritten. After you create new settings you need to collect a new darkfield and 
background for those settings. 

 
 

Thresholds and Tails  
 
Black and White Thresholds 
The AutoGain assigns pure black or pure white values to pixels at the lowest and highest values of a 
histogram. Those pixels under the red graph, but outside the vertical green lines are kicked out into pure 
black or white. How many pixels get kicked out depends on size of the "Thresholds". If thresholds are set to 
zero none get kicked out - all 256 grayscales that the camera receives are reported as is. 
 

  
 
The white and black limits are designated by vertical green lines.   All values below the black limit are 
assigned zero and all values above the white limit are assigned 65535. 
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The thresholds tell the green lines how far up the slopes of the histogram they should go.  Higher thresholds 
move the green lines closer together, concentrating the camera's contrast on the grayscales where most of 
the pixels are, and kicking edges out into pure black or pure white.  The default thresholds are 10, but some 
users like higher values, which gives a more contrasty image. 
 

  
 
The mapping between black and white is shown by a diagonal green line drawn between the green vertical 
line.  This line is straight for gamma = 1 and sigma = 1 in the live image.   For values of gamma or sigma, it 
is curved in live mode (See also "Grayscale Manipulation->The AutoGain Function". 
 

 
 
Note that the gamma during live operation is carried as the “base” for the final image.   So the diaganol line 
shown in the final image is always straight immediately after acquisition.  The actual (based plus added) 
gamma value is shown in the gamma control screen, however.   The system remembers the base values for 
the session until it is changed by the user.  
 
Tails 
The “Tails” move the green lines away from the center by a percentage of the distance between them.  
This takes some pixels that were pure black or white and puts them into the gray.  Positive Tails reduce the 
contrast of the image, and can be used to reduce “Blotchiness” caused by too many pure white or pure black 
areas. 
 
Negative tails increase the number of pixels which are pure black or white.  If you have some almost white 
features which you want to be pure white they will often show up on the histogram as small extra peak, such 
as in the picture below.  Use a negative tail to move the right green line to the left, making the features pure 
white. 
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********************************************************************** 
Grayscale Manipulation 
 
TEM images usually require some grayscale adjustment. Traditionally most user adjustments are done after 
the image has been saved, in a program like PhotoImpact. But there are a few utilities that work very well 
(even 'best') in AMT, and can give a nice image in the shortest time. The AutoGain function in the AMT 
program is constantly adjusting grayscales in your image, in order to put the camera's contrast range to best 
use in displaying your sample.  There are things you can to to effect the way that adjustment is made, and 
adapt it for special sample characteristics. 
 
    Contents 
 
    The Autogain Function 
    White and Black Level Adjustments 
    Gamma Adjustment 
    Sigma Adjustment 
    Image Sharpening 
    Image Processors 
 

********************************************************************** 
The AutoGain Function 
 
AutoGain 
In the histogram display shown here the area between the two vertical green lines represents the camera's 
output grayscale range, 0 to 255. The sample's grayscale range (the camera's input) is represented by the 
entire width of the display window. As you can see, the camera's output capacity is restricted to, or focused 
on, those sample grayscales which are occupied by your sample. This ensures that the available image 
contrast is put to best use displaying features, not analyzing the blacks and the whites. The camera actually 
does see all the sample's grayscales (the entire window), but pixels outside the green lines are seen as pure 
black or white, thus taking a minimum of the camera's analytical capacity. 

 
 
 
 
 
Thresholds and Tails 
The Thresholds and Tails control where the green lines go  (see  
"Camera  Settings  and  Control  Window").  If  the thresholds are  set  to 
zero, the green lines stay at the edges of the display window, so there is no 
enhancement of contrast in the occupied pixels.  Higher thresholds move 
the green lines closer together, enhancing contrast.  The default for 
thresholds is 10 but some microscopists prefer thresholds of 50 or more.  
The tails move the green lines away from the center, by a percentage of 
the distance between them.  Their main function is to control 
"blotchiness" when samples have a lot of extremely dark or light features. 
 
 

 
 

White and Black Level Adjustments 
 
A gridbar or other extreme black or white items often give your histogram extra sharp peaks on the left or 
right.  This forces the system to divert the dynamic range from the main collection of pixels and into the far 
black or white regions, making the main features look "washed out" (See "The Autogain Function"). Manual 
"Black" and "White" level adjustments are often the easiest way to correct the contrast. By manually moving 
the green lines with the sliders you can keep those extremes from hogging the contrast.  Essentially you're 
telling the camera "don't analyze what shades of black that gridbar has, just call it "black, and analyze my 
sample instead". 
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In order to change levels in live images you first have to click the AutoGain’s “Off” button. You can leave it 
off while you collect a final image.  Be sure to turn it back on before you change magnification or 
illumination.  

 
 
 
 
 

Adjusting  Gamma  
 
Adjustments to Gamma and Sigma can be done in a live or a final 
image, and does not require that the AutoaGain be turned off. 
Adjustments done in live imaging will stay in place for the session. 
 
Changing the Gamma changes the shape of the gain distribution 
line (the diagonal green line between the vertical green lines).  
Adjust by sliding the “Gamma” button right or left while viewing 
either a Live or Final image.  The same button is used for both the 
"Gamma" and "Sigma" functions.  If it currently says Sigma, click it 
and it will go to Gamma.  Clicking the "Neutralize Gray Map" 
button sets both Gamma and Sigma back to their default (neutral) 
value, which is one. 
  
 
 

 
 
 
The histogram's (red lines) in the following two examples have two peaks.  The larger one represents a 
concentration of pixels in the image's dark areas and the smaller one represents pixels in lighter areas.  In 
the first example Gamma has been raised by sliding the "Gamma" button to the right.  The gain line is now 
an up opening arch.  This makes the slope of the gain line small in the part of the grayscale occupied by 
the large (dark) peak and large where the image's lighter regions have their peak. 
 

 
 
 
 
 
 
 
Gain line slope represents contrast. Therefore a raised Gamma means 
more of the available contrast is assigned to the lighter regions. This 
makes it easy to see the difference between light and very light features, 
but difficult to see the difference between black and almost black ones.  
On the right side of the raised Gamma image below, one can easily 
make out the differences in the thickness of the substrate.  On the darker, 
left side of the image there's not much contrast available for 
distinguishing features.  Dark and very dark are compressed together into 
a dark blob. 
 
 
                 Gamma greater than one - light regions more contrasted 
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In the second example the Gamma has been lowered.  Now the gain line is 
a downward opening arch.  Its slope, and the fraction of the available 
contrast used, is much larger for the dark area peak than for the light area 
peak.  This means that the differences displayed between light and very light 
will be diminished, and features in the light area are less distinguishable. 
Difference in the dark areas however are much more distinguishable.  One 
can see what might be deposits in the dark tissue. 
 
 
 Gamma lower than one - dark areas more contrasted. 
 
 
Changes made to Gamma in live imaging are preserved in a recorded 
image even though the displayed gain line will straighten out.  The adjusted 
Gamma will still be in place when you go back to live imaging.  
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Adjusting  Sigma 
 
  If you click the "Gamma" button it becomes the "Sigma" button, and the 
slider bar now adjusts Sigma.  Like Gamma, Sigma changes that shape of the 
normally diagonal gain line, reapportioning the way contrast is distributed over 
the grayscales.  Raising Sigma makes the gain line an "S", so there is less 
slope on the black and white ends and higher slope over the middle 
grayscales. 
 
 
 
This puts more of the available contrast in the center of gravity of your 
histogram. The extra contrast in the middle is gained by sacrific ing a little 
contrast on the dark and light extremes. In biology the middle gray scales are 
often where most of your important edges are, transitions from middle gray+ to 
middle gray-.  So raising Sigma will often give a prettier picture, especially at 
low mag, and especially for users who print out their pictures. 
 
              
 
 
 
 
 
 

 
 
Sigma = 1                                                                  Sigma = 2 
 

 
   
 
 
 
 
 
 
 
Note: If the features you're interested in are light features surrounded by a light background, or dark features 
surrounded by a dark background, this is not the best adjusting tool (See "Gamma Adjustments").  
Clicking "Neutralize Gray Map" returns Sigma to its default of 1. 
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Image Sharpening 
 
Compare Images 
Sharpening can make 
a picture look prettier. 
It is most likely to be 
useful at lower mag, 
and with a sample that 
had some difficulty in 
preparation. It does 
involve a tradeoff. 
Sharpening can make 
a picture look gaudy 
and grainy and can 
interfere with the finest 
details. If your finest 
details are coming 
through O.K. you 
probably don't need 
sharpening.  Deciding 
that requires 
experimentation, 
comparing image next 
to each other in a 
processor. 
 
 
 
Not Sharpened 
 
 
 
 
 
Sharpening Level 1 
 
 
 
 
 
AMT Sharpening 
If you do sharpen 
image, AMT 
sharpening is probably 
the best way to do it, 
because it is native to 
the image collection. 
There are two way to 
sharpen in AMT: 
"Enhance current 
Image Only" (on a 
collected final image) 
and "Auto-Sharpen" 
(on all final images). 
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To enhance the current final image, click on "Proc/Meas" on the top menu and choose the Current Image 
enhancement option. 
 

 
 
 
 
To set the Auto-Sharpen level click "Set/Save" to open the Camera Settings Control Window. 
 
 
With either way of sharpening you can choose Level 1 to 3. Level 3 is the most extreme sharpening. ("3x3 
Median Filter" is a specialized function. It would be bad for normal imaging). Most sharpening jobs only 
require Level 1. 
The severity of the sharpening is set in the camera's configuration folder in the file "Sharpen.txt". 
 

 
 
 
The top number sets the level for Sharpen 1, the bottom number for Sharpen 3. Higher numbers in this file 
mean softer sharpening. In some labs those three numbers are changed to 180, 125 and 90, so that Sharpen 
1 is more like Sharpen 1/2 etc. 
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Image Processors  
   
PhotoShop, PhotoImpact and ImageJ are examples of image processors.  They have a variety of tools for 
manipulating grayscales and other image subtleties, sharpening, measuring, counting and analyzing. They 
also can be used to convert images into .jpeg images and for sending images to a printer. The two Image 
features you'll adjust most are Contrast and Brightness.  In order to print out nicely, images often need their 
contrast increased until they almost look gaudy on the computer screen.  When you adjust images in a 
processor, you probably want to save them with a different name, so you keep the originals.  
 
Other basic processor adjustments include Levels, Gamma and Curves, all of which are used to divide up 
the available contrast, so it gets used most effic iently to display the important features in your image.  See 
the PhotoImpact manual for directions on using its features.  ImageJ a subchapter here and a lot of free 
documentation online.  It has subroutines for counting particles, measuring area and doing fourier analysis.  
See  "In Depth Measurement and analysis using ImageJ". 
 
The AMT Capture Engine display typically has shortcuts to one or more image processors on it 
The top two icons on the left toolbar of this AMT display are shortcuts for opening PhotoImpact and ImageJ. 
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********************************************************************** 
Image Properties and Corrections 
 
The pages in this chapter are about how information for each pixel is collected, manipulated and stored.  It 
is intended for users that need technical specifications for things like flat field correction, frame averaging 
and bit depths.  Those printing these files as a general manual for new users can skip this chapter.  
 
    Contents 
 
    Bit Depth Of Images 
    Frame Averaging and Summation 
    Physically Based Flat Field Correction 
    Mag Factor In TEM Digital Imaging 
 

********************************************************************** 
Bit Depth of Images 
 
This page describes the collection and storage of information in binary registers.  The information can be 
important for those who want to electronically analyze images. 
The data is collected as follows 
 
For both live and recorded data  
 12 bit image data is generated by the camera and sent to the computer with two "8-bit bytes" per pixel. 
 The pixels values are forced to be justified "high" so that the most significant data is in the high byte.  

This means that the first 4 bits of the low byte are zero. 
 This does not make the data "perfect" in the sense that the maximum value is 65535. That comes later. 
For live data only 
 Only the most significant byte is used throughout the video chain. That is: the live data is 8 bits. This 

matches the SNR requirements of the TEM and display and allows faster data handling. 
 The raw data is dark field and background corrected for each frame, and the histogram of the corrected 

data is shown in the graphics window. This is unaffected by gain and offset. (So the "red" line does 
not change with White/Black/Gamma.)  

 The corrected live data is routed through an 8 bit video (Look Up Table) LUT for display. Since the data is 
not changed by the LUT all grayscale mapping is reversible. 

 Maximum data values of 255 are possible but usually neither achieved nor desired. 
For recorded data 
 All recorded data is summed in an array S of 32 bit deep unsigned integers. After integration S is divided 

by the number of integrations and transferred to a 16 bit data array. At this point the data is justified 
"high" but the maximum of 65535 is still not necessarily attained in the image.  It is simply the 16 
most significant bits of the "raw data."   Ideally, if the 12 A/D (analog to digital converter) were 
perfect, this array would lose some information for integrations of greater than 16 frames (16 x 12bits 
= 16 bits).  In practice the A/Ds are not noise-free and the process can tolerate ~64 integrations 
before this becomes a concern (and then only for a near saturated image).  

 The data is then dark field and background corrected with 32 bit arithmetic. The maximum of 65535 is 
still not necessarily attained in the image.  

 If there AutoGain (and the thresholds are > 0) then the data are rescaled so that the maximum is 65535 
and the minimum is zero.   

 The rescaling procedure was initially developed in conjunction with exposure   balancing. Ideally we 
"balance" the camera exposure times and gains so that setting the exposure in the live conditions 
automatically produces the the proper recording exposure levels.  Remapping the data using the 
AutoGain criteria gives a matching contrast level. In fact the use of "tails" makes this procedure more 
forgiving and will produce matching contrast even if the exposures are not balanced.  

 This procedure (coinc identally) made our images compatible with early versions of Photoshop and some 
other software,  which could not "see" the lower byte of a 16 bit TIFF image. Our competitor who 
justified the data "low" had big problems with this. 

 Setting Gamma to 1 and setting the thresholds to zero (with AutoGain ON) will disable rescaling but still 
give you the corrections. (Note that zeroing thresholds disables tails as well.)   This should give you 
quantitative data in the sense the camera becomes a light meter - as long as the dark and 
background images are constant. Absolute intensities become meaningful and can be calibrated.   It 
is also possible to disable background and dark field corrections, but I do not recommend this. 
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Histogram "Smoothness" 
 In principle dark field and background corrections add to the total uncertainty of the measurement and 

reduce the dynamic range of the data.  Corrected Image  =   <mean of Back-Dark>  [(Image + e1) - 
(Dark + e2)]/[(Back + e3) - (Dark + e2)]  (error/Corrected Image)2  =  [ (e1 + e2)/(Image - Dark)]2  +  [(e3 
+ e2)/(Back-Dark)]2  However, we integrate both the background and dark images during acquisition 
to keep e2 << e1 and e3 << e1 and Image ~ (Back-Dark) , so that this loss should be insignificant. 

 Any integration will increase the dynamic range by the SQRT of the number of integrations.  
 So we expect that the histogram will look relatively smooth at > 10 bits for a reasonable well il luminated 

image at the unity gain.  We would expect gaps to appear for high gains and poor illumination. 
 
Specific Suggestions for Diffraction 

The bit depth information of images suggests using a separate set of settings for diffraction 
imaging.  See the AMTHelpfiles chapter on Diffraction Imaging.  

 
 

Frame Averaging and Summation  
 
Typically TEM image quality is limited by beam statistics, where the signal-to-noise (SNR) per pixel is equal 
to the square root of the electron count assigned to the pixel.  The electron counts per pixel are limited in 
the CCD by the well depth of the sensor.  SNR can be increased by mathematically summing or averaging 
pixel values frame by frame. 
 
Live Modes: In live imaging the camera system offers a Quality Mode, which frame averages the live image 
using a recursive filter: 
 

 
  
 
where 
r(x,y)I is the incoming frame I 
R(x ,y)I is the frame averaged value of the Ith frame, and 
n is the frame averaging constant – as specified in the “frame average” in the Quality Setting in the "Camera 
Settings Control" form. 
 
Note that the result is normalized to 8 bit (256 levels) to accommodate the speed requirements of live 
display and processing. 
 
Recording Mode:  In the recording modes the camera system frame integrates multiple frames so that 
 

  
 
for I = 1 to n, where 
r(x,y)I is the incoming frame I 
R(x,y)I is the frame averaged value of the Ith frame, and 
n is the number of frames in the sum-as specified in the “Record Integrations” in the "Camera Settings 
Control" form. 
 



 32 

 
 
 
 
This result is normalized to 16 bits (65536 levels), which allows internal calculations to be done at high 
precision. 
 
The effect of multiple integrations is to increase the number of counts per pixel, which decreases the 
statistical noise.  This is a physical effect that can be modeled.  To first order the signal-to-noise ratio will be 
proportional to the square root of the integrations.  You get a 40% improvement from 2 integrations, 100% 
from 4, 180% from 8 and 300% from 16.  The most improvement per time unit is from 2 integrations.  
Integrations greater than 8 are rarely useful, because the noise becomes less than the detectability of the 
display and printer.  Mathematically, improvements will occur up to 64 frames.  These images need to be 
recorded in 16 bit TIFF format. 
 
The improvement in signal-to-noise ratio is physically limited by the instability and drift in the specimen.  It 
is also limited by the patience of the user. 
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Physically Based Flat Field Correction  
 
The flat field correction normally used in AMT images is a 
combination of dark-field subtraction and gain normalization that 
accounts for multiple non-uniformities in the image.  
Dark Image: Images are usually “flat-field” corrected.  In the first step of 
this correction the dark image is subtracted from the incoming, raw 
data.  In versions before 5.4.2.200 the dark image is collected by the 
menu operation. 
 
 
This function collects a base image with no light or electron signal.  
The program collects dark images appropriate for Survey, Focus, FFT, 

Super and Record modes.  They are stored in c:\AMTcommon\config\Settings\DefaultSettings or the other 
specifically named settings folders, as appropriate.  Dark images are frame integrated 8 to 16 times and then 
normalized to 16 bit format.  The dark image has both systematic and random components. 
 
The random component is almost always much less than the statistical noise of the electron beam.  The 
“DC” part of the systematic component can be significant for very low signal images where the raw signal is 
not 10 or more times larger than the DC component.  For well il luminated specimens the dark image 
correction is not significant. 
 
Dark images vary to a small extent with exposure time and are proportional to camera gain; so it is best to 
acquire them for each set exposure conditions.  Dark images are very stable; so that they are valid for at least 
a year under a given set of gain and exposure conditions – unless some physical change is made to the 
camera electronics. 
 
The dark image is always subtracted from the raw data (unless the dark image file is deleted from the 
particular AMT common folder).  So the first step in the flat field correction is: 
 
R'(x,y) = R(x,y) - D(x,y), 
 
where 
 
R(x,y) is the raw camera data, 
D(x,y) is the dark image and 
R’(x,y) is the dark corrected image. 
 
Background Image: The second part of the flat-field correction is background normalization.  The operation 
adjusts for the illumination variations in the lens and phosphor.  Background correction assumes a linear 
model for the modulation of the raw image.  That is the raw image is the product of the intensity of the ideal 
image and the modulation function.  
 
R'(x,y) = I(x,y)*M(x, y), 
 
where I(x,y) is the ideal image, and 
M(x,y) is the modulation of the image due to imperfections the optics, phosphor and TEM. 
 
Background correction requires the imaging a uniformly illuminated phosphor with a spread beam.  The 
collection of the Background Image is accomplished by a menu item: 
 

 
 
Background images are frame integrated 8 to 16 times and then 
normalized to 16 bit format. 
 
The modulation function is computed from the background image as 
follows: 
 
B’(x,y) = B(x,y) – D(x,y) 
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Where 
B(x,y) is the Background value at each point, 
B’(x,y>) is the dark corrected background at each point, and 
<B’> is the mean of B(x,y). 
 
Finally the ideal image is: 
 

 
 
Background images vary mostly with mechanical drift of the system; so it is best to acquire them every day.  
The linearity assumption can also break down under extreme illumination conditions and where illumination 
profile in the TEM varies with magnification.   This generally is not good operation, so spot size and 
apertures should be varied to avoid it. 
 

Magnification Factor in Digital Imaging  
 
    There is much confusion about the "mag factor" which is often specified by the TEM beam projection 
alone. From this perspective a bottom-mount camera has only ~115% times the magnification of a negative 
(mag factor = 1.15!).   Also by this standard a side-mount camera would have a mag factor of 0.3.   Both are 
misleadingly low and do not correspond to user experience, because they do not account for the size of the 
detector (capture size) or field-of-view, which is generally much smaller than a negative.  
 
    All digital output devices are about the same size as photographic prints. But the smaller size of digital 
camera detectors results in more enlargement than needed for a photographic print. A meaningful "mag 
factor" must include this enlargement value.  
 
    To compare magnification factors you should use a common observable reference: negative, viewing 
screen, monitor, or print. 
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********************************************************************** 
Measurements  and Calibration  
 
    There are a variety of tools available to help you measure, count and otherwise analyze the images you 
collect.  We'll discuss using and calibrating the ones that are part of the AMT Image Capture Engine, as well 
as some that are in other image processors. 
There is also a section on Lattice Imaging with bottom mount digital cameras.  
 
    Contents 
 
    AMT Measurement 
          Linear Measurement 
          Diffraction Measurement 
          Calibration 
          Measurement and Label Properties 
          Image Zoom 
          High Mag Calibration Issues 
    In-Depth Measurement and Analysis Using ImageJ 
          Length, Area and Angle Measurement 
          Particle Counting 
          Intensity Measurement 
          Image Drift Measurement 
          FFT 
          Viewing Serial Images 
          ImageJ macros 

********************************************************************** 
********************************************************************** 
AMT Measurements  and Calibration  
 
These are the utilities for measuring features on image in the AMT Image Capture Engine.  The basic ones 
are Linear (point to point) measurement and Diffraction pattern measurement.  Calibration is similar in the 
two utilities. 

 
 
Linear Measurements 
  
  

  
1. To make a linear measurement you first have to collect a final image. 
 
2. Next click on the ruler icon on the left tool bar (or on menu item Proc/Meas -
>Point to Point Measurement). This will open the "Measurements" window. 
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 3.The correct voltage and mag need to be entered in the measurement window.  If your system has 
communications, or if you've saved the image with the correct voltage and mag, the measurement 
window will already have the correct values. 

4. Select the units on the measurement form before making a measurement. 

  
 
 5. Make a length measurement by clicking once at each end of the desired feature to be measured. (Do 

not "drag".)   A line connecting the two points will be drawn and a measurement label added. The 
measurement will also be entered into the list on the measurement form.  Any of the measurement in 
the list can be given a label or comment, or be deleted, using the Measurement form's "Edit" menu 
items. The number of entries, and the calculated mean and standard deviation of the measurements 
are shown on the bottom of the form.  The measurements shown on the page will be preserved when 
the image is saved.  To remove them cl ick "Proc/Meas -> Undo Graphics". 

  
  
  

 6. The list of measurements can be saved as a text file, 
with the labels you have added being a separate 
tab delineated column. To do this use "File -> 
Save and Exit" on the Measurement form's menu.  
The Mean, Standard Deviation and units of 
measurement will be saved with the list. 
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Diffraction Measurements  
1.  Be sure to use the proper precautions for diffraction imaging (See "Diffraction Imaging"). 
2. After collecting a final image and going to Camera Out, click on the diffraction measurement button on 

the left tool bar. Alternately, click "Proc/Meas-Select Measurement Mode->Diffraction 
Measurement" from the upper menu. 

 

 
 

3. Select either diffraction spot measurement or diffraction ring measurement from the form that is displayed 
 

4. Diffraction Spot  Measurement.  The distance between diffraction 
spots is measured in the same way that point to point image 
distances are measured. Click once on each spot to measure 
the line between them. The measured distance will also be 
entered into the measurement form list and a line and label will 
be drawn on the image. 

 
 

5. Diffraction Ring Measurement  Select ring measurement instead of 
spot measureme nt. Measure diffraction rings by clicking on 
three widely spaced points on the ring. A circle with the 
appropriate radius and center will be drawn and labeled. The 
radius of the ring is determined and entered into the 
measurement list.    

 
6. To calibrate diffraction measurement use the same steps as those in linear measurement calibration (See 

"Measurement and Calibration->AMT Measurement->Calibration").  The diffraction default calibration 
is kept in difCal.txt and the diffraction calibration Table Entrees are kept in camConst.txt. 
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Calibration  
 
Calibration of point to point measurement uses the same principles as calibration of diffraction 
measurement. Both types are password protected. 
 
Default vs Table Entry 
There are two kind of calibrations for point to point measurement - Default or Normal  calibration and for 
more precision Table Entry calibration.  For many labs default calibration is all that is needed. This single 
calibration is used for measurements at all mags and voltages, and it is extrapolated linearly (if the 
magnification you work at doubles the calibration factor is doubled to compensate). For doing the default 
calibration choose a mag near the middle choice of the choices in the range of mags you commonly 
measure at. So if you usual range is say 4KX to 40KX, and that range has 11 choices, pick something near 
the middle choice - on most scopes that will be 12KX. 
 
As you get farther from the mag where the default calibration was done, the approximation will probably be 
less precise.  Therefore it is possible to do a Table Entry calibration, for any specific combination of mag 
and voltage. The table entry calibration will automatically be used instead of the default whenever you 
measure at that mag and voltage. The steps for doing table entrees is basically the same as for doing a 
default calibration, except you choose Table Entry under Calibration. AMT can store as many table entrees 
as you like, up to one for each combination of mag and voltage. 
The Table Entrees are kept in a file named "Mags4.txt" in the camera's configuration folder. You can bring 
that file up for review by clicking Calibrate on the Measurements Window's upper menu, and then clicking 
Show Mag/KV Table on the drop down list. The file has three columns: KV, Mag and Calibration Factor. 
The calibration factors may or may not be in scientific notation. There is one line for each of the table 
entrees you have done. If any line has a calibration factor that's very different from the rest, you may want to 
check the calibration at that voltage and mag again. Doing the table entry process over at a voltage and 
mag will overwrite that line on the table. The Default calibration is stored in the file "Calib2.txt" in the 
configuration folder. It gets overwritten when you redo default calibration. 
 
Units of the Point to Point Measurement Calibration Factor 
The calibration factors in Mags4.txt and Calib2.txt have units of “pixels per nanometer at 1000 X”. You can 
compare that to the calibration that is displayed on a saved final image if, while saving, in the Microscope 
Information window, you choose “Pixel Size” under Customize Magnification Display. After saving, find the 
Cal: display on the final image. Convert it from microns/pixel to nanometers/pixel by multiplying by 1000 
(unless it is already in nm/pix). Take 1/Cal: to get units of pix/nm. Since lower mag would obviously give 
more (image pixels)/(sample nm) divide the standard mag (1000X) by your picture's mag to get the 
calibration factor. So for instance if you take and save a picture at 3000X, and it displays Cal: = .004187 
um/pix: 
 
1/((Cal:) x 1000nm/um) times 1000X/3000X = 
 
1/(4.187nm/pix) times 1/3 = .0796 nm/pix 
 
.0796 is equal (within a ten thousandth) to the calibration factor for 3000X in Mags4.txt (or in Calib2.txt if 
there is not a table entry).  
 
Calibration Stability 
    The phosphor placement, lens spacings and phosphor to CCD chip distance are all static. Distances and 
dimensions are fixed so this calibration also stays fixed over time. Uncertainties in the magnetic fields 
generated by the TEM lenses (magnetic hysterisis), uncertainties in positioning the sample at eucentric 
height, and uncertainty in determining the boundaries of a calibration object (Grating replicas do not have 
sharp features.) are many times larger and are the precision limiting factors in overall magnification 
calibration. A periodic check of calibration is still a good idea, mainly to correct for human error.  
 
Calibration Steps 
 

1. The first step in calibrating your measurements is to collect a final image of something you know the size 
of, like a calibration grid. Calibrating at high mag requires a different kind of standard (see High Mag 
Calibration Issues). 

2. Next take some measurements.  If using  a repetitive grid measure a number of squares to reduce error.  
Measure in both directions. Delete the measurements that are obviously wrong.      If calibrating diffraction 
measurement, use spots which are a known distance apart, or rings of known size.     



 39 

  
3. When you've got your 

target measurements 
cl ick the "Calibrate" 
button.  Besides options 
for the Normal and 
Table Entry calibrations, 
there are options to 
display the calibration 
tables for point to point 
measurement (Mag/KV 
Table) and for 
diffraction measurement 
(CamLength/KV Table). 
There's also a "Reset" 
option, for deleting all 
your table entrees and 
starting over. Resetting 
is not necessary for 
redoing a table entry or 
the default calibration. 
New values will 
overwrite the old ones.   

4. After you choose the 
type of calibration and 
enter the password the 
Magnification 
Calibration window will 
appear (or, for 
diffraction, the 
Diffraction Calibration 
Window).      
 

5. At the top of the Calibration window you choose whether to use the last (or selected) measurement or the 
Mean of the measurements as a standard. If you feel that one of your measurements is very representative 
use that as a standard. If you're measurements give kind of a spread, say, over different directions, use the 
Average as a standard. 
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6. Enter the length of the known objects measured (Correct Distance).  The window contains an optional use 
calculator to help calculate the distance of repeating patterns. 

7. Clicking "Proceed with Calibration" finishes that calibration and adds the factor to the appropriate file(s). 
8. Use the same steps for calibration of diffraction measurement. The diffraction default calibration is kept in 

difCal.txt and the diffraction calibration Table Entrees are kept in camConst.txt. 

 
 
Measurement Labels and Properties  
 
 Editing Measurements: A measurement may be selected from the measurement list and a label added.   

Click Edit on the Measurement form menu. 
 Saving Measurements and Labels: If you choose to save a measurement list, measurements and labels 

are saved as two tab delineated colums in a text file. 
 Deleting Measurements: A highlighted measurement on the list deleted with the Delete key.   If no 

measurement is highlighted the last value on the list is deleted.  Only measurements currently 
showing on the image can be deleted. 

 Measurements in Images: An image saved with measurements displayed will retain those displays. To 
remove them before saving click  proc/meas -> Undo Graphics. 

 
Image Zoom 
 
    Image Zoom is a measurement and survey tool. The "Zoom" icon is near the bottom of the left toolbar.  
To use it one first needs a final image, either a new one or a reopened one. 
 

 
At the bottom of the Zoom icon it displays the current zoom factor.  "Off = 1" is 
the unzoomed image. 
 
Use the Zoom function by clicking once on the Zoom icon and then clicking on 
the image.  The point where you click will become the center of the zoomed 
image.  Zooming always increases displayed mag by a factor of 2. 
After you've zoomed in, right clicking the image zooms out (unzooms) by one 
step. 
 
 
 
    Below is a final image of a biological specimen.  Suppose we want to measure 
the width of the widest part of one of the cilia in the lower part of the image. 

 
 
 
 
 
    After we click once on the Zoom icon 
and once at the tip of the red arrow the 

picture below is displayed.  The 
sample is displayed twice as large, 
and the Zoom icon button says "2X".  

The point where we clicked is now in 
the center of the image.  If we had 
clicked the wrong place, we could undo 

our mistake by right clicking, to 
unzoom, and then zooming again. 



 41 

 
    Here we've zoomed in a second time, so the 
displayed mag is 4 times the original.  This is a 
good place to get the measurement.  The 
measurement calibration is automatically 
adjusted to measure in the zoomed state.  Click 
the measurement icon (the ruler) to open point 
to point measurement.  Make sure the mag and 
voltage displayed on the measurement form are 
correct. 

 
 
 
    The same procedure can be used for diffraction measurement. 
 

Calibration at High Magnifications  
 
 
To calibrate in the higher magnification ranges it is a good idea to use a material standard.   Available 
materials are: 
 Catalase, which has two fairly large lattice spacings 87.5 A and 68.5 A. 
 For higher mags Crocodilite has 9A and 4.5A. 
 Copper Phthalocyanine is another material that is sometimes used but it is beam sensitive. 
 
Lattice images of gold or graphitized carbon can also be used.   The carbon layers tend to bend and finding 
any place with more than a few planes visible is not easy. There are also (very expensive) superlattice 
material that is made especially for TEM calibration. 
 
Most suppliers have these materials available. You can check them out (for example) at: 
 
SPI’s website:   http://www.2spi.com/catalog/index/  
Crocodilite is SPI catalog # 02908 – AB 
Catalase is SPI catalog # 02905 – AB 
The MagiCal superlattice standard is SPI catalog # 02218 – AB. 



 42 

********************************************************************** 
Measurement and Analysis Using ImageJ  
ImageJ is an image processing application written by Wayne Rasband. It is a work of the United States 
Government, is in the public domain and is open source. It is available from the National Institutes of Health 
(NIH Web Site ). All modifications, source code, applications and additions to this program by AMT are also 
freely available from AMT. 

This is a supplement to the existing documentation forImageJ . Its main purpose is to highlight and introduce 
operations typically used with CCD images obtained by transmission electron microscopy. This orientation 
also describes customizations made by AMT for TEM imaging. 

AMT Automatically Embeds Scaling Information 

Spatial calibration information is incorporated into the tiff file header when AMT’s Capture Engine saves a 
file. The customized version of ImageJ will read the calibration parameters for an image when it opens an 
AMT tiff file. If the calibration information is not present, an alerted box will remind you to manually 
calibrate the image (Use ImageJ's menu Analyze/SetScale to do this). 

Calibration information may be lost if you open an image in another image processor and then overwrite the 
original image. 

 
    Contents 
 
    Length, Area and Angle Measurement 
    Particle Counting 
    Intensity Measurement 
    Image Drift Measurement 
    FFT 
    Viewing Serial Images 
    ImageJ macros 
 

********************************************************************** 
 

 

Measuring Length Using ImageJ 

Open a Tiff Image in ImageJ and select the line tool from the ImageJ toolbar. The last image saved by the 
AMT Capture Engine may be opened by pressing the F5 key. 

Se lect the line tool from the ImageJ tool bar 
  

 

Position the cursor at one end of the object to be measured. Click and drag to the other end of the object. 
Type F1 to enter the length of the line drawn into the measurement list. A line between the start and end 
points and a label will also be drawn on the image. Repeat the process for other objects that you wish to 
measure. For difficult or small objects you can use the zoom tool and then make measurements. More 
accurate measurements, of course, are obtained by collecting a higher magnification image. 



 43 

Measuring Perimeter and Area Using ImageJ 

Distance along an irregular path or a perimeter can also be 
measured by selecting the Segmented Line Selection or 
the Freehand Line Selection tools in the ImageJ toolbar. 
You will need to select the measurement (area, perimeter, 
etc.) to be displayed in the menu Analyze\Set 
Measurements Menu item.     After you have drawn the 
curve type ctrl-m. The measurements selected will be 
displayed in a Results box.     Units are the length units of 
the image. In this case nm and nm2.  

 

 

Measuring Angle Using ImageJ 

Angles can be measured by selecting the angle measurement tool.      

 
 
On an open image double click on the first point, single cl icking on the vertex, and click once more at the 
terminus of the final ray. After you have drawn the angle type ctrl-m.     The angle measurement is displayed 
in a Results Box. 

 
 



 44 

Particle Counting Using ImageJ  
 
ImageJ can automatically count the particles in a whole image or a selected part of the image.   You 
determine what gets counted as a particle by thresholding the image’s grayscale values to suppress 
background features and accentuate the desired features, and also by setting limits to the size of a partic le. 
It’s also possible to require a set degree of “roundness” to be a particle.  The steps below are a tutorial for 
particle measuring.  For more information on this operation see the website:  
http://rsb.info.nih.gov/ij/docs/ .  

1. Open ImageJ, either by clicking on the ImageJ icon on the left side of AMT’s display, or by clicking on 
ImageJ in style="">“Start -> Programs”. 

2. Open a saved image in ImageJ.  For this tutorial, open “ 
C:\AMTCommon\AMTSampleImages\Imgld1cal.tiff”. 

3. Use ImageJ’s crop tool to separate an AMT image from caption area.   One click with the tool will effect 
the separation. After the separation reselect the square tool, and close the caption window. 

 
 

 

4. Next we separate the particles from rest of 
the image by setting the black/white 
thresholds around a narrow set of gray 
values.  Make sure the image to be 
measured is selected (clicked).  On the 
ImageJ menu click “Image -> Adjust -> 
Threshold”.  Under the histogram that 
comes up you can change the thresholds by 
moving the bars or click “Set” to type values 
into a window.  A lower value of 17 and an 
upper value of 70 worked well for our 
immunoGold partic les at 10KX.   You may 
want to experiment with these settings, but 
when you find values that work, be consistent 
will all your samples.  After setting the 
thresholds click “Apply”, and click all three 
boxes in the dialog box setting threshold 
pixels to black and other pixels to white. This 
makes the image “binary” having all black 
particles on a white background. 
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5. Tiff files saved from the AMT program have tags 
that will set the measurement scale for ImageJ.  If 
other kinds of images are used you’ll need to set 
the scale, using a feature of known size, in 
“Analyze – Set Scale”.  

 

 
6. In “Analyze – Set Measurements” select which 

measurements you’d like saved for each partic le, and the 
number of decimal places to be displayed in the results.  
Counting small particles in a 10KX image requires six 
decimal places.  For other mags or for large particles 
you may have to experiment with decimal places.  
Grayscale measurements will not be terribly meaningful, 
since we’ve made the image binary (each pixel black or 
white) when we set thresholds. 
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7. The “Result” window (upper right below) displays a number and the selected measurements for each 
particle.  The “Summary” window gives the Count number, Average Size, Total area of the particles and the 
Area Fraction covered by the particles.  The “Particle Size Distribution” window show a histogram with the 
particles grouped into bins according to their area.  The statistical values displayed below are for particle 
area, not grayscale values. 
 

 
 

For more information about analysis with ImageJ see the website http://rsb.info.nih.gov/ij/docs/. 

 

Measuring Intensity Using ImageJ 

Intensity Measurement Cautionary Note 

Measurement of image intensities and gray scales can also be done. However, it is important here to 
remember that the Capture Engine normally applies a contrast enhancement to images as they are aquired 
and displayed. This improves the appearance but modifies grayscale information. If quantitative measures 
are to be applied to image intensities, the contrast enhancement of the Capture Engine should be turned off 
and images should be saved as 16 bit tiff files. 

To measure the gray scale value at a point simply position the cursor at a point of interest and the gray scale 
intensity is displayed in the status bar just below the ImageJ tools.  Alternatively, the Point Selection tool can 
be used.  
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    Select a pixel with the tool and then type ctrl-M to display the intensity in the Results window. The values 
in the Results window can be saved. 

Line profiles can be generated by drawing a line through the features and then selecting Analyze\Plot 
Profile or pressing the ctrl-K key. To improve the statistics of the plot one can select a rectangle in which 
case a column average profile is generated.   

 
 

Image Math 

Extraction of interesting features from a complex image can be a challenging aspect of image analysis. It is 
very useful to be able to perform simple mathematical functions on whole images and between two images. 
Once a sequence of operations is found to be useful a macro can be created to automate that sequence. 
Embedded in the particle counting macro discussed below, for example, is an algorithm to extract small 
dense particles from a complex image that includes both tissue and gold partic les. This algorithm relies on 
some simple math. The image is first blurred and then a portion of it is subtracted from the original image. 
This tends to enhance small partic les and suppress the background. The Image Calculator in the Process 
menu permits one to add, subtract, multiply, divide, and apply several other operators to pairs of images. 
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Image Drift Measurement 

Installation  
Use the ImageJ installer ImageJ138g_V306_20070404 or later installer. Run Setup.exe and accept 
defaults. The installer will install the required startup macro, and the TurboReg plugin that it calls. 

Setup 
The input tiff images should be placed in a single folder and have file names that end in _xxxx. Where 
xxxx is the time of acquisition. E.G. test_0000.tif was acquired at time = 0000. The time units are seconds. 
All images should be taken at the same magnification and written by AMT's Capture Engine which embeds 
scaling information into the tiff image header. This information is used by the macro to calculate a real drift 
rate. 
For testing purposes the installer placed a canned set of test images in the folder 
C:\AmtCommon\AmtSampleImages\CannedImages. These images will be used to demonstrate use of the 
drift measurement macro/plugin. 

Running the Macro 
The macro is activated by selecting the menu item Plugins\Macros\AMT Drift Measurement or equivalently 
by selecting the F3 key. This will display an introductory message with acknowledgements to the TurboReg 
plugin authors and instructions.    
 

 

 
Click OK.  Use the "Choose Directory" dialog that is displayed next to locate the images 
whose drift you wish to measure.    
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The macro will display the first image and request a choice of length units.  
 

Select the unit and click OK. 

The macro will now sequentially open the images measure the drift relative to 
the previous image and enter the results into a Log table.  
 
 
 

 
 

  
These results may be saved to a file by selecting "File/Save As" on the Log form if desired. 
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Fast Fourier Transform Using ImageJ 

Backgound 

The Fourier transform expresses an image in terms of the spatial frequencies in the image. A sharply focused 
image will be rich in high spatial frequencies. Large uniform areas are represented by low frequencies. 
Images with repeated features will have Fourier Transforms with repeated strong peaks. This can be used to 
select various parts of an image and can be very useful in removing artifacts, or improving image sharpness. 
ImageJ has a built in FFT and in addition there are several plugins posted on the NIH web site (NIH Web Site 
Plugins ) that implement their own specialized versions of the algorithm. See for example:   Band pass filter 
 Arbitrary size 2D and 3D transforms 

There are also plugins that rely on the FFT as an integral part of the algorithm they implement. These 
inc lude convolution, filtering, and deconvolution plugins - these algorithms are more efficient when 
performed in fourier space. Many of these plugins are provided with references to the literature. 

Doing the FFT 

Doing the FFT of an image is straightforward. open an image. Select the region of interest on an open 
image and then in menu Process menu select FFT. Since the FFT is usually implemented for regions that 
are even powers of 2, the nearest power of two sized region is automatically used in the FFT.  

 
  



 51 

Viewing Serial Sections Using ImageJ Stacks  
 
A sequence of images obtained from a serially sectioned sample can be used to create an ImageJ "Stack".  
A "Stack" is way to animate and visualize a sequence of images and ImageJ has routines that use stacks to 
display 3 dimensional information.  In addition to the intrinsic capabil ities of ImageJ plugins have been 
written to augment the 3D viewing capabil ities of ImageJ. 
 
The first step is to obtain a sequence of serial images through an object of interest. In a real experiment this 
is done by sectioning the object and then carefully collecting the sections in the order that they were 
sectioned.  To experiment with and become famil iar with the ImageJ stacks we inc lude a simple macro to 
generate synthetic images which can be assembled into a stack.  The macro is “AmtDrawStack.txt” and is 
located in the C:\Program Files\ImageJ\macros folder. 
 
 
1)    The “AmtDrawStack” macro is a very simple macro that creates 50 images (01.jpg to 50.jpg) and stores 
them in the folder "C:\images\ImageJ \SampleStack. "  You must create the folder 
C:\images\ImageJ\SampleStack before running the macro.  Install the macro  “AmtDrawStack.txt by copying 
it into the folder:  C:\Program Files\ImageJ\macros.  Another useful macro for this exercise is 
AmtOpenSet.txt.  This macro opens the 50 images generated by AmtDrawStack.  Install the macro  
AmtOpenSet.txt by copying it into the folder:  C:\Program Files\ImageJ\macros  
 
2)    The Volume Viewer plugin “Volume_Viewer.jar” was obtained (10/23/2006) from the ImageJ web site:   
        http://rsb.info.nih.gov/ij/plugins/index.html#analysis 
The web page “Volume Viewer.htm” has installation information, references to other possibly useful plugins, 
and author contact information.  
 
3)    Install the “Volume_Viewer.jar” file by copying it into the 
 C:\Program Files\ImageJ\plugins folder.  
 
4)    Obtain serial images through an object of interest. To experiment with the plugin using synthetic 
(generated) images run “AmtDrawStack.txt” by going to the ImageJ menu Plugins\macros\Run and then 
locating the macro in the folder C:\Program Files\ImageJ\macros. The images generated by this macro will 
be found in C:\images \SampleStack 
 
5)    Open the images in order.  Use the macro AmtOpenSet or you can open the images directly from 
ImageJ using the keyboard shortcut Ctrl-O and then double cl ick the image icon.  These shortcuts may be 
helpful since Image J does not have a group open command. 
 
6)    Create a Stack from the images. Go to the menu “Image\Stacks\Convert Images to Stack. 
 
7)    You can animate the stack by going to the menu: Image\Stacks\Start Animation. This will cycle through 
the images.  You can also save the stack by using the File\Save or the File\SaveAs menu. You must save the 
stack in the tiff format. 

 
8)    Once you have a stack go to the Plugins\VolumeViewer menu 
item. This plug in will allow you to observe the images from different 
orientations. ImageJ also has some viewing capabil ities in addition 
to the simple animation in the Z dimension (See the other options in 
Image\Stacks). In particular, “Image\Stacks\3D Project” allows you to 
create an animation of the images rotating. Pixels of certain values 
can be set transparent so that embedded objects (like the cone) can 
be visualized. Try “Image\Stacks\3D Project” with the following 
parameters: 
 
 

 The Upper and Lower Transparency Bounds allow one to specify 
pixel densities that are ignored. Since the cylinder and cone have 
different gray scale values setting the upper bound between the two 
values (eg. 170) makes it possible to visualize only one of the 
structures. 
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ImageJ Macros 

Macros are sequences of commands, which can be executed as a single operation. A few examples of AMT 
generated macros have been mentioned and used above. Particle counting, drift measurement, and 
measurement and labeling make use of both intrinsic ImageJ operations, plugins (to be discussed below) 
and macos. An existing macro can be run by selecting the menu Plugins\|Macros\Run and then navigating 
to the location of the macro. Macros are usually kept in:   C:\Program Files\ImageJ\macros   Macros can also 
be installed as a menu item or assigned a keyboard shortcut. 

ImageJ has over ninety standard macros that are supplied as part of the initial installation. These macros 
range from functions that alter every image pixel, to measurement of image parameters and dimensions to 
drawing tools. More information is available on the NIH web site.  ImageJ Plugins 

The macro StartupMacros.txt is a special macro that runs when ImageJ is launched. It can be used to 
define shortcuts to macros and place macros in menus and tools. AMT has set this up to install a useful 
sample set of macros as menu items and shortcuts. It can be modified by the user as desired. 

The AMT shortcuts are: 

AMT Shortcuts 

Shortcut Name Description 

F1 
Draw and 
Measure 

Draws a l ine between points defined by the l ine selection tool. The distance between 
the points is calculated, entered into the results table and drawn on the image. 

F2 Measure The same as ctrl M just a single key needs to be depressed. 

F3 
Drift 
Measure 

Runs the drift measurement macro. 

F5 
Open Last 
AMT 
Image 

Opens the last Image Saved by the AMT Capture Engine. 

 In addition to these there are several ImageJ standard shortcuts. 
See  http://rsb.info.nih.gov/ij/docs/shortcuts.html 

ImageJ Recording Macros 
The easiest way to create a macro is to open the command recorder under the menu item 
Plugins/Macros/Record Then record a series of commands, and click Create. In record mode, each menu 
command you use generates a call to ImageJ's run() method. This method has one or two string arguments. 
The first is the command name. The optional second argument contains dialog box parameters. 

ImageJ Plugins 
Plugins are another form of extension available to the user of ImageJ. Plugins are very powerful and execute 
much faster than macros. More information as well as over 100 plugins are available on the ImageJ web 
site:  http://rsb.info.nih.gov/ij/docs/menus/plugins.html   ImageJ has a large body of users and many plugins 
and macros have been created and contributed to the NIH site. In addition there are links there to other sites 
with additional macros, plugins, and documentation. 

AMT Tools and Macros 
AMT has generated some tools and macros that you may find useful. Macros in the C:\Program 
Files\ImageJ\macros folder whose name starts with AMT may be useful or provide useful examples for 
functions you may wish to build into your own macros. Macros are written as text files and these files begin 
with comments that document their function.  

The AMT Crop 
function strips away the 
AMT image label so 
that image processing 
can be done on just the 
image. 
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********************************************************************** 
Diffraction  Imaging 
 
This chapter describes procedures and precautions for acquiring diffraction images. 
 
    Contents 

Acquiring A Diffraction Image 
     Diffraction Settings 

********************************************************************** 

Acquiring a Diffraction  Image  
 
Precautions:  Certain precautions are necessary for taking diffraction images. Diffraction produces bright 
concentrated spots or rings which can damage the phosphor of your camera. Lower illumination and shorter 
exposures are preferred.  Please follow the following four precautions:  
 Use a smaller spot size (controlled by condenser 1).  If your largest spot size is 1, try 5 or 6. 
 Put in the smallest condenser aperture. If your diffraction images are dim you can experiment with a 

larger aperture later. 
 Find and focus diffraction patterns with the traditional TEM viewing screen (side mount - phospor 

retracted, bottom mount - viewing screen down). 
 Use a “central beam blocker” if available. Many electron microscopes have one built in. It eliminates the 

bright central spot of a diffraction image. 
 Minimize "camera in"  time. Using the first three precautions you should be able to get a nice pattern on 

the TEM viewing screen, without damaging the phosphor. Now insert the phosphor (for bottom 
mounts lift screen) for a short time to collect the image.  Collect a final image and then retract the 
phosphor (for bottom mounts lower screen) right away. 

For best diffraction image quality, if your camera has it, click “Display->Low Light Mode on/Click to Change 
to Diffraction Mode.”  This prevents overloaded pixels from “blooming” onto neighboring pixels.  Don't forget 
to change back for normal imaging.  Reopening the program will also bring back normal (Low Light) mode.  
 
Diffraction Settings  
 
Those who do diffraction often and analyze images offline can increase efficiency by creating a separate 
set of camera settings for diffraction using the Camera Settings And Control Window.  The settings described 
below are designed for uniform quantitative calibration.  (You can get "prettier" pictures using Gamma and 
non-zero thresholds.) 
For information relevant to quantitative analysis of diffraction images, see the AMTHelpFiles chapter Data 
Analysis - Bit Depth of Images.  
 Set recording gain to 1. Use record exposure time to adjust brightness. 
 Set white and black thresholds to zero and run with AutoGain ON. This disables the Autogain's rescaling, 

but leaves corrections in place.  (Note that zeroing Thresholds disables Tails as well.) 
 Set gamma to 1.  These steps should give you quantitative data in the sense the camera becomes a light 

meter - as long as the dark and background images are constant. Absolute intensities become 
meaningful and can be calibrated. 

 Use as many final integrations as possible, keeping total exposure time below 3 seconds. 
 Save these conditions for diffraction - or some name that you like. The saved conditions will contain the 

zero thresholds.  Do not use this condition as your default unless you do only diffraction. 
 Acquire a dark field (no beam) and background with very uniformly spread beam.  I believe that the 

background should be taken once and only once to normalize the radial falloff of the lens. (Phosphor 
graininess should not be important in diffraction).  If you are measuring absolute intensities picture-
to-picture, do not repeat the background acquisition, unless you can measure the beam current 
independently and take new backgrounds under the same beam intensities (within your error 
tolerance).  But note relative intensities within a pic ture will not be degraded by a new background.  

 Note that your saved backgrounds and dark images are valid only after new "diffraction" conditions are 
saved or recalled. Check your display to make sure you are saving to the right place. 

 As a precaution, save a copy the entire folder containing your settings and correction images.  These can 
be found in c:\amtcommon\config\Settings\name of settings file There will be one .txt file and eight 
.bin image files in this folder.  In fact it would be good idea to backup the entire Config folder to 
keep all your settings. 

 Save your diffraction images in 16 bit format. 
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********************************************************************** 
Lattice Imaging with Bottom MountDigital Camera 
1)  The phosphor pixel size determines the minimum magnification needed to see lattice.  The minimum 
case has a bright region centered on one pixel and the dark region centered on its neighbor.   So an 
absolute limit of 2 pixels for each “period” of the lattice oscillation.   
2)  The ERB camera has a ~23 micron pixels.   So, a 3A lattice period would need to project to 46 microns 
on the phosphor.   This corresponds to a minimum magnification of 46x10 -6 m/3x10-10m or 150,000x, if the 
lines are horizontal or vertical. 

  
 
3) Slanted lines need higher magnification. The worst 
case is 45 degrees, where the lattice period corresponds 
to 65 microns.   To see lines at this angle the minimum 
magnification is 220,000x. 

4)     The camera is below the film plane so that the 
magnification at the camera is 10 to 20 % higher than 
the “dial” or “film” magnification.   Thus, 200,000x should 
be able to resolve 3A lattice in the ideal case. 

 

 
 

5)  But the world is not perfect.  

a) This model assumes that the lattice sampling is 
perfectly synchronized with the CCD array, which is 
nearly impossible to achieve.   There will always be 
sharing between adjacent pixels.   There is also the 
possibility of Moire patterns, if the minimum 
magnification is used and there is only a small difference 
in lattice and CCD periods. 
 
b) The model assumes high contrast in the image and 
nearly perfect response of the camera.  Neither is true. 
 
 
 
6)   The general “rule of thumb” is to use ~2 to 3 times 
higher magnification than the ideal.  This means that 
you should be more comfortable shooting 3A lattice at 
~500,000x with a bottom mount camera. [Note: These 
values will be good for most bottom mount 1k cameras 

made by us or out competitors.  Some 2k cameras have smaller pixels (i.e. Gatan’s UltraScan = 15 microns, 
AMTXR60B = 12 microns); so a lower magnification can be used.  Our large field, 7 mpixel bottom mount 
XR100 has 24 micron pixels; so the upper resolution limit is the same as the 1k but the field is 2.6x larger 
(Mag factor is 2.6 smaller).] 

 

********************************************************************** 
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********************************************************************** 
Display Options  
 
The AMT Image Capture Engine has lots of tools to change the way things are displayed during live and 
final imaging and while measuring. 
 
    Contents 
 
    Changing Image Displays 
          Refresh Display 
          Contrast Inversion 
          Center Cross 
          Show Captions 
          Undo Graphics 
          Draw Rectangular Grid 
          Darken 
          Image Zoom 
    Show/Hide Options 
          Show/Hide Control Panel 
          Show/Hide Large Mag Display 
          Show/Hide Live Scale Bar 
          Other Show/Hide Options 
    Preferences Display Items 
          Speed Live Or Quality Live As Default 
          Set Measurement Marker and Cursor 
          Continuous Mag Read 
 

********************************************************************** 
 
Changing Image Display  
 
The AMT Image Capture Engine has lots of tools to change the way things are displayed during live and 
final imaging and while measuring. Most of these options are accessed either the "Display" or "Proc/Meas" 
menu items. 
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  Refresh Display  
 
This button is not needed often.  It allows the user to refresh the display of a window. 

 

 

Contrast Inversion  
 
Sometimes a user wants an image to be displayed with black pixels appearing as white and white pixels 
appearing as black, like a negative.  This kind of display can be helpful when counting gold partic les, for 
instance.  The Display menu provides buttons for inverting the display, either just in the live image (with final 
images being normal), or on both the live and final images. 
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To invert contrast click the "Display" button on the upper menu and, on the drop down menu, click "Select 
Contrast Inversion". 
 

 

The contrast options window allows inverting 
contrast on live image only, live and final images, 
or neither. 

 

 
 After contrast is changed the buttons 
become buttons for returning to normal 

contrast. 
 

 

 
  

 

 

 

 

Center Cross  
 
  The Display menu provides a number of alternatives for showing a white cross over the center of the 
image.  One can show the cross on the Live image only, on all final images or on just this final image. 
 

 

After a center cross option is activated, the clicked button 
becomes a switch for removing the cross. 
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Show Captions  
 
  The last option in the Display menu give the user the option of showing, in the AMT display, the captions, 
Mag, HV, scale bar, and other information that is saved with an image, . This is the readout that appears at 
the bottom of an image when it is viewed in PhotoImpact or another image processor.  To use this options 
one first needs to be displaying an image that has been saved.  When an image is opened in a different 
image processor, such as PhotoImpact, this information appears underneath the image. 

 
 
 

Undo Graphics  
 
This option is under the "Proc/Meas" menu item.  After you add graphics to a final image by measuring, 
drawing grid lines or creating a text box,  clicking "Undo Graphics" will remove them to restore the original 
image.  
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Draw Rectangular Grid  
 
Having a regular grid on your image can facilitate counting or identifying features. To draw one click 
"Proc/Meas" and select "Draw Rectangular Grid".  
 

 
 
 
A window opens where you select the number of horizontal division for the grid. 

 
 
 

Darken  
 
The "Darken" menu item temporarily darkens the entire monitor.  It might be used while collecting a dark 
image, for instance.  To bring back the display just cl ick anywhere on the monitor. 
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********************************************************************** 
Show/Hide Options  
 
Near the right of the menu bar is the button for the "Show/Hide" options.  With these options you can make 
visible or invisible the Live Scale Bar and Control Panel, or change the size of the Mag Display. 

 
 
Contents 
 
    Show/Hide Control Panel 
    Show/Hide Large Mag Display 
    Show/Hide Live Scale Bar 
    Other Show/Hide Options 
 

********************************************************************** 
Show/Hide Control Panel  
 
One option under "Show/Hide" is for the Control Panel on the right and left side of the image.  Hiding it 
might give you a more uncluttered view of the image. 
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 Image with the Control Panels gone 
 

 

 

 

 
 
 

Show/Hide Large Mag Display  
 

    
 
By clicking this item one can show 
or hide the large mag readout at 
the lower right part of the display. 

                 

 
 
 
 
 

 
 
 
 
 
Show/Hide Live Scale Bar  
 
  A scale bar can be displayed in live images.  This scale bar is not saved with the image.  It is for use in live 
or final images, but only in the AMT display.  If you have TEM communications and continuous live mag 
updating, the scale bar will automatically change size or dimension when you change mag on the TEM.  
Otherwise it will change size after you manually enter the mag with a saved image. 
 
 

 

The Scale bar normally appears in the lower left corner of the 
image, but it can be moved anywhere by right clicking a location.  
When the Live Scale Bar is showing, the menu item become "Hide 
Live Scale Bar". 
 

 

Other Show/Hide Options 
 
  "(Show/)HideMeasList" controls the Measurements window, which can get hidden behind the AMT display 
during measurement. "FFT Control" has options for Show/Hide and size of the FFT window. There are also 
options to show image collection and saving times, and information about the Show/Hide feature. 
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********************************************************************** 
Preferences Display Items  
 
   In File -> Preferences there are a number of choices to be made for the default display.  These include: 
 
Setting the (cursor) crosshair size 
Making the default for live imaging "Speed Live" or "Quality Live". 
For systems with communications, choosing to update the mag reading continuously or just with final 
images collection. 
Setting a default path to use when images are save using "File -> SaveAs". 
 
 

 
 
   Contents 
 
    Speed Live or Quality Live as Default 
    Set Measurement Marker and Cursor 
    Continuous Mag Read 
 

********************************************************************** 
 
Speed Live Or Quality Live As Default  
 
  When you open and use AMT it will automatically start imaging with either "Speed Live" and "Quality 
Live".  Speed Live is faster, but Quality live averages together several frames in live mode to average out 
noise. Quality Live often gives a prettier live image, but the tradeoff is that imaging runs a little slower. You 
can toggle between them with the "Speed/Quality Live" button The choice you make in Preferences is 
which one the program open with. 
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Here's where you would change the speed during live imaging: 

 

 

Set Measurement Marker And Cursor  
 

 
 
 
The Measurement Cursor surrounds the point which the mouse moves to points to measure the distance 
between them. The point can be surrounded by a circle or by crossed by crosshairs. 

 
The Measurement Marker  marks the endpoints of a line segment after it has been measured. The Marker 
can be Small, Medium or Large. 
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Continuous Mag Read  
 
  "Preferences -> TEM Communications Options -> Enable/Disable Continuous Mag Read"  turns on and 
off the continuous live update of the mag display during live imaging.  If it is off, in scopes with 
communications, mag will be updated when a final image is collected.  The reason for providing the 
choice is that on some scopes the live imaging display is smoother without continuous mag updates. 
 
 

 
 
 

Below is the mag display, which gets updated. 
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********************************************************************** 
Authenticating Images  
When the "Authenticate" mode is activated the camera software takes extra steps to make sure you can verify 
that your saved images are original and haven't been tampered with. This feature was designed to help labs 
comply with federal regulations (Code of Federal Regulations (CFR) Vol. 21 Part 11), which mandate that 
pathology images used for data generation are raw data and must be authenticated and archived. 

When in Authentication mode certain features are activated and some features are deactivated.   

Features Activated 

• Images are Saved as "Read Only" 
• An Authentication Marker is added to images. This marker is not visible and is lost completely if the 

image is saved in an image processor. In addition, this marker is a function of the image. Changes in 
the image will modify the marker thus flaging the alteration. 

• A password is required to activate the application. 
Features De-Activated 

• Saved As is deactivated. Images are saved only through Case Study. This way images are 
sequentially numbered which aids in archival accounting of images. 

• Saving images in the jpg format (a lossy compression based format) is disabled. Only tiff format is 
supported. 

• Saving measurement lists in text format is disabled. 
Ask your system administrator to activate the Authentication mode and assign user names and passwords. 
 
Verifying the Authenticity Of Images 
You can check the authenticity of stored images in the AMT program. You'll find the "Verify 
Authentication" button under "File" on the top menu.     

 

When you click the item the AMT Authentication Checker 
window will open. In the left pane of the window, locate the 

folder containing the images you want to verify. Double click 
the folder and the filenames of its images will be displayed 
in the second ("All Tiff Images") pane.   

 

To verify the images click the 

"Check Images" button on 
the lower left of the form. The 
images will be sorted into 

Original Images and Other 
Images (those that no longer 
have the originality marker). 

In this example image #3 
doesn't pass the test.  
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 Double cl icking an image 
filename in either the 
Original Images or Other 
Images pane will open that 
image in AMT. The two 
buttons at the lower right of 
the form are for saving the 
sort, either by printing it out 
or as a text file on your 
computer. This is what the 
saved text file looks like. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

************************************************************ 
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********************************************************************** 
Database 
AMT Database and Meta-data AMT maintains a database of the meta-information associated with images 
that are aquired using the Capture Engine. This is information such as the magnification of the image, TEM 
mode, the accelerating voltage of the TEM, the microscopist, the time and date the image was acquired, 
scaling information, the laboratory name, as well as two user supplied caption lines and up to 6 keywords. 

This information is stored in several ways to provide flexability for the user and permit recovery of the 
information if it is inadvertently deleted. The information is written into an rtf(Windows WordPad) file, a 
predefined Windows Access database, the tiff header, and optionally into a logo band directly on the image. 

 
    Contents 
 
    AMT History .rtf File 
    Access Database File 
    Tiff Header 
    Logo Band 
 

********************************************************************** 
 
The AMTHistory RTF File 

Metadata is written into the file C:\AMTHistory\AMTImagingDataBase1.rtf each time an image is saved. This 
is simply a text file which saves each field of information on the TEM Info Form that requests/displays the 
metadata just before an image is saved.    
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  On systems with TEMs that support communication with external applications the Capture Engine is able to 
obtain much of the information automatically (Grey background). On TEMs that do not support 
communication the user will need to enter (if desired) the Magnification, accelerating voltage, TEM mode, 
xy position, and tilt. Some fields - caption lines and keywords always depend on user input(White 
Background). 

Items that are checked on the information form will be written into the image caption band. However, all the 
information is written into the rtf database. This is simply a tab delimited table with the following fields:  

FileName 
Microscopist 
Date_And_Time 
TEM_Magnification 
CaptionLine1 
CaptionLine2 
Pixel_Calibration 
X_Position 
Y_Position 
Tilt 
Accel._Voltage(kV) 
TEM_Mode 
TEM_Facility 
Account 
KeyWord1 
Keyword2 
KeyWord3 
Keyword4 
KeyWord5 
Keyword6 
 
If the field is empty it is left blank in the rtf file. 
 
Importing the RTF into a Spread Sheet 

An rtf file can be opened by Windows word Pad and a tab delimited table can easily be imported into a 
spreadsheet program. As an example, to import into Microsoft Excel:    

Select a cell where you want to place the data. Go to the Data Menu and select Import:      

 

Confirm the information that the import wizard presents.      
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The table is tab delimited    

    

Chose the data format for the spread sheet     
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Confirm the location you selected above.    

 

Other speadsheet programs are likely very similar. 
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Access Database 

If Microsoft Access is installed on the acquisition system the information is entered automatically into an 
Access Database file (mdb). The Access database is a Microsoft standard file and can be moved to an 
external work station and opened with Access 2007. 

Information In The Database 

Each image saved enters information into the fields shown in Table 1. The database has 6 keywords 
reserved for use by the microscopist. The principle investigator or lead microscopist for a project should 
define these categories and suggest possible entries. For example, keyword 1 can be designated as the 
sample type. In a biological setting this might tissue type, keyword 2 could be a common feature or 
organelle, keyword 3 could be a suspected pathology. In a materials setting the first keyword might be the 
sample material, project, or experiment. The second might be a description of features in the image. 
Another keyword might be a patient designator, or the source of the sample.   Again the keywords should be 
defined by the Principal Investigator to facil itate recalling information about important groups of images. 

Using the Database 

Database filtering aids in finding examples of previous work with a particular sample, feature, account, 
microscopist, date, or technique. For example a facility manager might be interested in how many images 
were taken for a particular project or account. 

Filter by Account 

Open the full database (See for example Figure 1).    

 
Figure1  Select the Home tab and the account column and then click on the filter icon (funnel) in the filter 
and sort section. This will display a panel listing all the accounts that have been entered (Figure  2).   
 
 
Leave only the account of interest checked and then click OK. The display will collapse to show only 
those entries associated with the specified account “XYZ-001” (Figure 3).  
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Scrolling left and right one can see the microscopists, who did the work, 
when the work was done, where images were stored, as well as captions that 
were entered on the images and keywords that characterize the sample and 
observations. 

 

 

Filter by Keyword 

The keywords allow one to extract from the database only those information records that relate to a 
particular field. In this case, for example, keyword 4 has been used to store a patient number. One can 
extract records related to only a particular patient.   

 

 
Report Generation  

Tabular representation of the database can be very informative, but may be lacking esthetically. This is 
especially true when some of the fields are not critical (or are blank). Microsoft Access allows one to design 
a report form and display the information in the underlying database in a fashion that is more pleasing. 
These reports can be created and modified by the user to suit differing needs. Filtering operations are still 
available in this format. 
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A Very Brief Tutorial 

This is necessarily a very brief tutorial. For more information there are some references at the end of this 
section. 

Open the database, select the Create tab, and then select the Report Design icon. This will generate a blank 
report. Then click the Add Existing Fields Icon. This will display the fields in the AMTImgInfoTable in a 
panel to the right of the blank report form (Figure 5). Fields can now be selected and dragged from the panel 
on the right to the report form. These fields and their labels can be positioned and sized as desired. There 
are a variety of tools on the Design, Arrange, and Page Setup tabs that can be used to generate a report 
layout. View icon on the left allows you to switch between design, layout, report view, and print preview 
displays. To save the report layout click on the disk icon in the top left corner and supply an appropriate 
name. Figure 6 shows a simple report.    
 
 
It is important to note that the filtering operations can still be applied from a report. Select the field of 
interest and then click on the filter icon in the tool bar. Access will display possible field entries (Figure 6) 
select those desired and click OK. Only records matching the filter requir ements will be displayed. At this 
point additional filtering may be done or the report can be printed.  
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Figure 6 

References 

This is an extremely brief introduction meant to get you started. Many books have been written on the use of 
Microsoft Access. See for example:   Microsoft Office Access 2003 Inside Out by John L. Viescas Microsoft 
Access 2003 Forms, Reports, and Queries (Business Solutions) by Paul McFedries Access 2003 Bible  by 
Cary N. Prague, Michael R. Irwin, and Jennifer Reardon 

Appendix 

 

AMT Access Database Fields  

Field Name Description  

ID A sequential number identifying the image.  

File Name The full path name where the image is originally saved.  

Microscopist The name of the microscopist.  

Date/Time The date and time the image is collected.  

Magnification The TEM Magnification setting.  

Caption 1 A text string that the user can enter as a label on the image caption band.  

Caption 2 A second text string used as an image label.  
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Pixel Size 
The size of a pixel at the current magnification in microns/pixel or 
nm/pixel. 

 

X Position The x-position of the sample as read from the microscope.  

Y Position The corresponding y-position of the sample as read from the microscope.  

Tilt The sample ti lt.  

Accelerating Voltage 
(kV) 

The accelerating voltage of the electron microscope in kV.  

Mode The mode of the microscope. This is usually Imaging or diffraction.  

Account The account under which the work is being done.  

Facil ity The microscope facil ity name.  

Keyword 1 See main text.  

Keyword 2   

Keyword 3   

Keyword 4   

Keyword 5   

Keyword 6   
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Meta-data In the Tiff Header 

The meta-data is also stored in the tiff header. Information from this location is used to scale images 
automatically when opening them in ImageJ. In addition it may be possible in some image processors to 
display this information for examination.    
 
 

 
Corel Paintshop Pro Information Display 

Some databases may also have the capabil ity to extract this information for entry into database fields. 
 
Fields in this tag are delimited by a Carriage Return and occur in the following order: 
TEM_Facility 
Date 
Time 
TEM_Magnification 
Print Width 
Accel._Voltage(kV) 
TEM_Mode 
CaptionLine1 
CaptionLine2 
Keyword1 
Keyword2 
X_Position 
Y_Position 
Tilt 
Pixel_Calibration 
Pixel_Calibration - this is a duplicate and will be phased out in a future version 
Calibration Unit 
AMT tag format version marker 
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AMT Logoband 

Information in separate files may become separated from the image to which they refer. Not all image 
programs open and preserve the tiff information tag. If they do not then openning an image in the image 
processor and saving over the original image effectively strips away the metadata. To address these 
limitations we have introduced a new method for embedding this information directly into the image. The 
information is encoded into pixel intensity and then placed in a logo band at the bottom of the image. 

To activate this method of storing the metadata be sure to check the "Show Logo and Metadata" checkbox 
on the TEMinfo Form.    

 

When the image is saved 
a band containing the 
AMT Logo and the meta-
data is added to the 
bottom of the image.    

 
 
The information can be 
extracted from the image 
by selecting the Extract 
Metadata menu option.     
 
  

This reads the information and creates an html file in the same 
folder. This file can be opened by your browser to display the 
metadata.     
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********************************************************************** 
Montaging  
 
AMT's montage package employs stage motion to scan an array of images. Thus it is capable of collecting 
low magnification montages.  The program can be used with or without a motorized stage. 
 
    Contents 
 
    Collecting Images For A Montage 
    Collecting And Naming Conventions 
    Stitching With Panavue Image Assembler 
 

********************************************************************** 
Collecting Montages  
 
1) Select the appropriate Montage Acquisition Mode from the Special Acquisitions menu. 
 

  
In the AutoStage option, the computer controls the stage motion and image 
collection automatically after setup. 
In the User Controlled option, the camera application guides the user 
through the montage process, but the user controls the stage. 
If the TEM provides stage control, both options are enabled. If not, only 
User-Control is enabled. 
 

 
 2) Provide a name for the folder where montage images will be saved. You may select a previously existing 
folder in which case you will be asked if you want to delete the contents of that folder. Answer YES if you 
intend to overwrite everything otherwise NO.  
  

 
 
3) The montage control panel will appear. 
 
 
 

 
4) The image will go “live.”   You should now 
set up the parameters for acquisition. 
 
 
 
Typically overlap should be 20% for 
automatic stitching. Note also that 
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mechanical stage drives have an inherent uncertainty or repeatability error associated with them.  This 
variation depends on the microscope.  At higher magnification this uncertainty is a greater fraction of the 
image field of view.  Generally higher magnifications will require larger overlaps to compensate for stage 
variations. 
 
15+% cropping is needed for side mounted cameras to reduce "S" distortion of the projector lens. But 0% 
cropping should work for bottom mounted cameras. 
 
Set Final Image Bit Depth refers to the number of bits used to represent the intensity in a pixel.  At present 
this value must be 8. 

 
Choose the mode for setting the magnification. Select either  final 
magnification  OR the number of snaps (pictures) in the longer axis. The 
magnification or snap values are selected in the pull down menu 
immediately below. 
 
Tuning and Panavue Version allows you to enable/disable backlash 
correction, specify a Stage Drift Time (the amount of time required for the 
stage to stop drifting after it has arrived at a programmed position.) and 
select the version of the Panavue Image Assembler that you are using. 
 
5) Select the acquisition area for the montage by drawing a ROI (region of 
interest) and then clicking Accept ROI or alternatively click Use Whole to 
select the whole field of view. 
 
 
 
 

Selecting a ROI. 

 
6) Once the area is selected the program will set the magnification (If the microscope remote command set 
supports external control of the magnification.) or request that you do so. 
 

 
  
  
Set the TEM to the requested magnification, focus the TEM, 
and adjust the intensity.   The intensity as observed on the 
histogram should be approximately centered. 
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Click Start Collecting Montage.  Status of the collection ia displayed in the panel on the right.  
 
AutoStage Mode: 
The program automatically moves the specimen to the appropriate positions and records images.  Status 
messages will be displayed in the Montage Control Message window.  When done a message box will 
announce that acquisition is complete.  The images and a Panavue project file (“xia” file) will be stored in 
the folder specified in Step 2. 
 
User Controlled Mode: 
This is a computer assisted mode of operation, which prompts the user to move the specimen and indicate 
when to record a picture.  Instructions are displayed on the montage control panel on the right. 

 

 

Motion prompts refer to the direction of motion of the image - not the stage. 
 A. Start by moving the lower right region of the intended montage to the center of the screen (i.e. move 

image up and left.)  Then cl ick  Next Frame. 
 B. After recording the image, the program will prompt you to move the image in a certain direction (left, 

right or down) and will freeze the expected overlap region.  The overlap region is duplicated on one 
side of the live image.  This region will flash occasionally to show the live image behind it or display 
in partial transparency the image behind it.  Move the image in the direction of the duplicate and 
line them up. 

 
There is also a movable guideline that can be used to assist following a specific point across the field.  
Clicking the mouse on the image moves this line. 
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 C. When finished moving, click on Next Frame again.  Then Step b) will repeat until finished. 
 D. When done a message box will announce that acquisition is complete.  The images and a “xia"  file 

will be stored in the folder specified in Step 2. 
If you have Panavue Version 3.4 you will be asked if you wish to assemble the montage now (in the 
background) or save it for later assembly.  If the montage is large you may wish to save and assemble later as 
stitching can take quuite a while.  See Stitching with Panavue Image Assembler for an introduction to the  
use of a Panavue project. 
   
 

Collection and Naming Conventions  
 
Normally the AMT Capture Engine will generate a Panavue project file for the images it collects from a 
montage area.  In some cases, for example a large irregular region, the user may wish to create a custom 
project to assemble the images.  The following discussion explains the oder that images are collected and 
the naming convention used. 
 

1) Montage images are collected in a serpentine path 
(boustrophedonic) from the bottom right corner of the 
image to the upper left corner. 
 
2) The image names have two components as shown 
below. 
 
 
The first component is a number that corresponds to the 
reverse of the collection order. The second corresponds 
to the row and column. 
 
3) These image plus an overview and information file 
(with images positions) are stored in the folder created for 
the montage during the setup process.. 
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Montaging with PanaVue Image Assember 3 

The montage procedure has been developed with the 
Panavue image stitching program in mind. The montage 
routines in the AMT Capture Engine automatically names 
images in the Panavue project order. However, for Version 
3.4 of Panavue the Capture Engine not only aquires the 
montage images but it also creates and runs the stitching 
project. Since the user may elect to assemble the montage at a 
later time the following discusses some aspects of running a 
Panavue project. You can also obtain more information from 
the Help menu in Panavue. It should not be necessary to 
create the project. 

The user may delay assembly of images for a later time.  In addition, the quality of the automatic 
stitching result will depend on the content of the image, distortion and amount of overlap. There are 
also option settings for Panavue that may need to be changed for a given environment. A manually 
assisted procedure is also available in Panavue. 

1) Open the Panavue project created by the Capture Engine by double clicking on the xia file in the 
montage folder you defined during setup.  This will open the Panavue project. 

2) Go to the filemenu and select Open All Images.  This will open all the images in the project. 

3) Use the Action menu and select Full Run or type Ctrl R. 

4) The resulting image will be displayed when stitching is completed.  Note: The lower right hand 
image has a micron bar and a label with the TEM Direct Magnification in it. You can then choose to 
save the image (We recommend an 8 bit gray scale TIFF format.). 

5) You should evaluate this image and determine whether stitching has been successful.  If there is 
a problem with the result you can change the options and/or reset the project for manual positioning 
and repeat the stitching.   This might be necessary if, for example, the overlap is less than 30% and 
the resulting image has not been stitched properly.  These options are found on the Set Options tab 
of the Panavue project. 

6) This image can also be compared with the low resolution Overview.tif image in the project 
folder.  This image was created when the region was defined at low magnification. 
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********************************************************************** 
Web Broadcasting  
 
All AMT cameras have an  option to produce an NTSC signal that can be used for a live "webcam" signal. 
This capability is useful for remote collaboration, demonstration and instruction.  
This section describe the equipment, software and procedures for routing this signal for display via the 
internet.  
 
    Contents 
 
    Web Broadcasting Manual 
 

********************************************************************** 
AMT Web Broadcast Manual  
Rev1.3 
10Jan2006 
 
This option requires: 
 
Scion AG5 Video Output Board (or nVidia Dual Display Video Card with Video Output and cables) 
Winnov Videum 1000 VO Plus Board 
WebCam32 software 
Scion Cable 
Male BNC to male RCA adapter 
 
1)  Follow Scion’s standard installation procedure to install the AG5 board 
        OR 
     Install the nVidia card with dual display, set the secondary display resolution to 640x480. 
2)  Follow Winnov’s standard installation procedure to install the Videum 1000 board. 
3)  Connect the output of the Scion board to the input of the Videum board using the Scion cable and the 
BNC to RCA adapter. 
4)  Install the WebCam32 software. 
5)  Configure your network.  If you have a fixed IP address users outside your local area network will be able 
to connect to your port and view the images. 
Check with the network administrator at the customer location to see if this is allowable.    
 
(You can find out what addresses are currently assigned to your system by running 
Start|Programs|Accessories|Command Prompt and then typing ipconfig in the black window that is 
displayed.)   If fixed addresses are permitted go to Start|Settings|Network and Dial-up Connections. Right 
cl ick on Local Area Connection select Internet Protocol(TCP/IP) and click on the properties button.   Click 
on the Use the following IP address and enter the IP address, Subnet mask, and Default Gateway. 

 
 
 
6)  Configure WebCam32 – 
    a)  Launch WebCam32 
    b)  Select File|Videum Video Capture 
    c)  Select File|Preferences 
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d)  Expand TCP/IP|Features - check all option boxes 
except Palm Access Enabled.     
 
e) TCP/IP|Access – Confirm that the IP Address shown 
is the same one returned by ipconfig above.   Take note 
of both the IP Address and the port.   They will be 
needed later. 

 
 

 
 f)  Expand Device|Format Select a standard image size of 
320x240 and check black and white.  Set Format to RGBT: 
24bit RGB. 
  
 
    g)  Select Device|Source. This will display the Video 
Source Settings window below.  Set the popups to 
Composite, NTSC, and Camera as shown. Picture 
adjustments of Brightness 50, Contrast 25, Saturation 25, 
and Hue 50 are reasonable places to start. 
 

 

 
Be sure to click the Default command button so that the next 
time the program is run these settings will be used. 
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 h)  Expand Image|Video and set JPEG 
Compression Quality to around 50%.   
Check Preview Enabled to display the 
image being sent out.   This can be 
turned off later.  A small preview 
window appears which allows you to see 
what is being made available to the 
remote observer. 

 
i)  Select Camera Cycler and make 
sure that only Videum Video Capture is 
checked. 

 

7)  Go to Start|Programs|WebCam32.   
Create a shortcut (right click) and drag 
this into the bottom task bar. 
 
 

8)  The remote user will need to run 
AMTWebCast.html to observe the video stream.  A 
prototype of this is located in 
C:\AMTCommon\config.  A complete listing is 
appended here with the required changes 
highlighted. 
a)  Open Notepad - edit AMTWebCast.html file to 
customize: 
     1)  The header string <H1 align=center> header 
string <\H>. 
     2)  The ip address and port number must be set 
to match 6e. 
     3)  If you wish to test other resolutions Width and 
Height specifications can be modified.   These 
values should match acquisition parameters set up 
in Cam32 ( Device Format 6f).  If the network 
connection between the Camera computer and the 
remote computer is fast enough it may be 
reasonable to increase the size of the transmitted 
image. 
9)  The AMTWebCast.html file can either be 
distributed to remote users or posted on central web 

site and the URL distributed to the remote users. 
  
 
Appendix 
1)  Replace the following -shown in blue- with the name of the Microscope Facility: 
Microscopy Center Image from AMT Camera on XYZ TEM 

2)  Replace the IP Address and port – shown in green in 4 places 256. 256. 256. 256:8888 - with the correct 
IP Address obtained from ipconfig and displayed in the TCP/IP Access Preferences page and the port from 
the Properties page. 
3)  To try a different resolution use the Preferences Device|Format to select another resolution and replace 
the values 320 and 240 below.   Shown in orange.  It may also be necessary to adjust form sizes set here to 
350. 
  
AMTWebCast.html Listing 
 
<!-- Sample Modified from NIH/Rocky Mountain Lab --> 
<html lang="EN"> 
<head> <title>Image Pull</title> </head> 
<body> 
<H1 align=center> Microscopy Center<BR> 
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Image from AMT Camera on XYZ TEM </H1> 
<TABLE align=center border=0 cellPadding=1 cellSpacing=1 width="75%"> 
<TR> 
<TD align=center height=350 width=350 vAlign=middle style="BACKGROUND-COLOR: lightyellow"> 
</TD> 
<TD align=center height=350 width=350 vAlign=middle style="BACKGROUND-COLOR: lightyellow"; 
HEIGHT: 350px; WIDTH: 350px> 
  
<script LANGUAGE="JavaScript"> 
<!-- 
browserType = navigator.appName;                   
newImage = new Image(); 
document.onstop = document_onstop; 
  
function startstop_onclick() 
{ 
     if (startstop.value == "Stop") 
     { 
          stopLoad(); 
      
     else 
     { 
          startstop.value = "Stop"; 
          newImage.onload=loadNewImage; 
          loadNewImage(); 
      
} 
  
function document_onstop() 
{ 
     stopLoad(); 
} 
  
function stopLoad() 
{ 
     newImage.onload="";     
     startstop.value = "Start"; 
     window.status = "Live video stopped ..."; 
} 
  
function loadNewImage() 
{ 
    uniq = new Date(); 
    uniq = uniq.getTime(); 
    document.images.webcam32.src=newImage.src; 
    newImage.src="http://256. 256. 256. 256:8888/video/pull?"+uniq; 
    window.status = "Displaying live video ...";     
} 
  
function initialImage() 
{ 
     uniq = new Date(); 
     uniq = uniq.getTime(); 
     newImage.onload=loadNewImage; 
     newImage.src="http:// 256. 256. 256. 256:8888/video/pull?"+uniq; 
    document.images.webcam32.onload=""; 
} 
  
if (browserType == "Netscape") 
{ 
     document.write('<IMG SRC="http:// 256. 256. 256. 256:8888/video/push" align=center width=320 
height= 240>'); 
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} 
else 
{ 
     document.write('<IMG SRC="http:// 256. 256. 256. 256:8888/video/pull" name=webcam32 
onload="initialImage()" align=center width= 320 height=240>'); 
} 
  
//--> 
</script> 
  
<P><INPUT id=startstop type=button value="Stop" LANGUAGE=javascript onclick="return 
startstop_onclick()"></P></TD> 
<TD align=center height=350 width=350 vAlign=middle style="BACKGROUND-COLOR: lightyellow"> 
</TD> 
</TR> 
</TABLE> 
</body> 
</html> 
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********************************************************************** 
Directions for Changing a Phosphor  
 
Occasionally the microscope's technic ian or user is called on to replace the phosphor for an AMT camera.  
It's a simple procedure but requires a little caution.  This chapter describes the change procedure for side 
mount and bottom mount systems. 
 
    Contents 
 
    Phosphor Evaluation 
    Phosphor Types 
    Changing Sidemount Phosphors 
    Changing Bottommount Phosphors 
 

********************************************************************** 
Phosphor Evaluation 

Phosphors may accumulate dust and occasionally it is possible to burn a phosphor by exposing it to a beam 
that is too intense for an extended period of time. If a dust particle is thin enough that the background 
correction is able to compensate for the lost intensity then cleaning the phosphor can be delayed until an 
opportune time. Unfortunately in some cases the dust particle is too thick or moves relative to the 
background image when charged by the beam or jarred by the motion of phosphor insertion. In these cases 
the phosphor should be cleaned immediately. 

When evaluating the state of a phosphor it is sometimes the case that a background corrected image 
confuses the issues. It may be helpful to turn off all corrections for this purpose. This can be done by 
selecting the menu item:   Corrections/Diagnostic Tools/Suspend corrections and Zero Thresholds 
 

Phosphor Types  
 
There are three main physical designs for phosphors used by AMT.  For all three, in the scope, the 
aluminum side points up (towards the beam). 
 
Film Type (IF) 
 
One design is called Film Type.  It has a shiny aluminum coating on the side facing the beam, and 
phosphorescent material on the bottom.  Both sides are delicate and shouldn't be touched.  The transport 
case protects both sides. 
 

 
 
 
Round Glass Bottom (IB) 
 
Another type type is round with glass on the bottom and a dull aluminum finish on the side that points toward 
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the beam.  They can be placed, glass down, on a soft surface, or lifted by something soft on the glass side, 
but don't touch the aluminum side. 
 
 

 
 
Rectangular Glass Bottom 
 
Like the round glass ones, these have a glass bottom that can be touched by something soft, and a delicate 
gray side facing the beam.  They are transported in a curved bottom dish with the delicate side down.  As 
with the other types, grab it by the edges.  
 
 

 
 
Glass side up in dish. Aluminum side points toward beam.  
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Sidemount Phosphors  
 
Here are the three types of sidemount phosphors, each mounted in its respective holder for installation.  
They each have either the shiny aluminum side or the dull aluminum side up.  
 
 

 
 
 
Procedure for Changing Round Phosphors 
 
 
1) Vent the TEM camera (film) chamber only. Some old JEOL100/200C and Zeiss “orange column” 
microscopes need to vent the column as well. You never need to vent the gun. 
 
2) Make sure the mirror is in the retracted (camera out) position. You may have to remove the pneumatic 
tube that powers the mechanics. Remove the 35 mm retracting flange from the TEM, using a hex wrench for 
the bolts. Side-mount systems normally install the retractor on the right [exceptions H7000/H7100 and some 
orange column Zeiss’s]. 
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3)  Remove the phosphor.  After removing the assembly put the mirror in the extended (camera in) position 
for working on it.  Loosen the four set screws (one at each corner) that hold the phosphor in the holder.  In 
film phosphors there are small holes in the rim of the phosphor. The small hex wrench you used for the set 
screws will fit into the holes, allowing you to pry up the phosphor so you can grab it by the sides and move it 
to an empty holder.  Glass phosphors can be pushed up from the bottom by something soft.  Be careful to 
not have anything touch the mirror. After removing the phospher, make sure the set screws are fully retracted 
so the new phosphor will drop into place. 
 

 
      Film Type Phosphor 
 
 
4) Mount the new phosphor.  Grabbing it from the sides, lift the new phosphor into place.  If it's a glass 
phospher you'll have to flip it after lifting out of the transport case to get the dull aluminum side up.  The 
film ones are transported with aluminum up. After the phosphor is in place, tighten the corner set screws. 
They need some torque, but not much. If the phospher is a film type, carefully check the top to make sure 
there's no buckling of the surface. 
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          Glass Type Phosphor 
 
 
5) Gently blow off any dust. Using a can of compressed air or other gas, blow off the top of the phosphor 
and the front of the mirror surface.  This requires caution.  Hold the can at least eight inches away from 
the target. Pull the trigger part way, to get a low pressure stream of air.  Blow the stream at your hand 
first to set the stream and make sure it's all gas, no l iquid. During the cleaning spray, keep the can in 
the same orientation - don't turn or shake it. 
 
6)  For putting the assembly back on the column, make sure the mirror is retracted (camera out).  Be 
sitting for the insertion and put your elbows on the table top. 
 
 
Rectangular Phosphor Replacement 
 
If you need to replace a rectangular (GA) type phosphor, it wil l probably arrive already fastened into a 
mounting bracket, with a flat cover held onto the top with small screws.  You change the bracket using 
the two screws at the rear.  Make sure the glass side is down when mounting.  After the bracked is 
attached remove the cover.  Be careful not to let the screws or the screwdriver touch the surface of the 
phosphor. 
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Bottommount Hardware  
 
Changing a bottom mount phosphor requires removing all the AMT hardware from underneath the column. 
The kick cover, camera and lens, and the lens mounting block can be removed without breaking vacuum.  
Remove the lens and camera together.  Be sure not to tamper with the screws that hold the lens to the 
camera. The Flange to TEM contains the phosphor.  It is fairly heavy, although it shouldn't require a floor 
jack. Use a rubber band to fasten something soft over the glass on the bottom of the Flange before you 
remove it. 

 
 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Procedure for Changing BottomMount Phosphors 
 
The phosphor is in the flange to TEM.  When you have the flange on a table carefully remove parts until you 
get to the phosphor.  Mark parts as to orientation and position for reassembly.  Be careful not to drop screws 
onto the phosphor.  Film type phosphors have holes in the rim which can be used for lifting. Glass phosphors 
can be lifted from the bottom by something soft.  When you're done with replacement the phosphor's 
aluminum side, either dull aluminum or shiny aluminum, should be facing the beam. 
 

 
 
When the phosphor is in place gently it blow off any dust using a can of compressed air or other gas. This 
requires caution.  Hold the can at least eight inches away from the target. Pull the trigger part way, to get a 
low pressure stream of air.  Blow the stream at your hand first to set the stream and make sure it's all gas, no 
liquid. During the cleaning spray, keep the can in the same orientation - don't turn or shake it.  Use the same 
procedure on the other hardware parts as you reinstall them.   
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********************************************************************** 
Computer Issues 
 
This chapter discusses computer issues which are commonly handled by scope users or their I.T. Department 
personnel. 
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********************************************************************** 
User Computer Accounts   AMT computers are usually shipped with two accounts for use: 
"Administrator" and "User1".  Both accounts have administrative privileges in Windows. If you create 
separate accounts for camera users they will not be able to use AMT until the new user has full control of the 
folders listed below. The folders' "Security" tab might not be available until, in Windows Explorer, to go to 
Tools->Folder Options and on the "View" tab, unclick "Use Simple File Sharing". 

Users need  Full Control to the following folders (including sub folders): C:\AMTcommon 

C:\AMThistory C:\Images C:\ImgMeas C:\Montages NOTE: A network drive, or other designation for saving 

images, must be write enabled also. If your AMT software has these folders in the "All Users" folder, they 

should already be fully accessible.  
 
Basic Microsoft Utilities  
 
The TEM digital camera is a high speed data acquisition system that puts heavy real-time demands on its 
computer and generally produces many, very large files. Maintaining performance requires some routine 
maintenance procedures that are readily available in the Windows operating system.  This sections 
describes some of the most basic operations that should be done monthly.   
 
Checkdisk: 
This is your most powerful tool for restoring effic iency. To turn Checkdisk on find the C drive in "My 
Computer" or "Windows Explorer", right click it and click "Properties". "Tools," where you will find "Error 
Checking". Click "Check now" and select the first cleanup option, "Automatically fix file system errors." 
Then the system will tell you to reboot your computer.   
 
Note: If you select "Scan for and attempt recovery of bad sections" this operation will take a long time. 
This operation should be used only when you suspect a physical problem with the hard drive or you have a 
few hours to spend on the operation (i.e. overnight). 
 
Safe Mode: 
This utility is a barebones version of Windows, which is used for diagnostic and repair purposes. It also 
rewrites registries and repairs files during the boot process, so just opening in Safe Mode can sometimes fix a 
system. To get into Safe Mode  "Restart" your computer. Before Windows starts, push and hold down the F8 
key on your keyboard. This should produce a screen with several options including the SafeMode Start 
option. The startup takes a few minutes during which file names are displayed. After the startup your Desktop 
Icons will be enlarged since the graphics card is not running. When the computer is done starting up tell  it to 
restart again, this time without pushing F8.  
 
Defrag: 
This can be done after Checkdisk and may not be needed every time. See how many files are fragmented 
when the Defrag display starts.  The Defrag actuator is on the C drive's "Properties - Tools" tab along with 
"Error Checking". This is another time consuming procedure for lunch or overnight break.  
 
Disk Cleanup: 
If you do not browse the internet you probably will not have a lot of temporary internet files plugging things 
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up. However, it still wouldn't hurt to do a cleanup occasionally,  especially if you're on a network. To start the 
process click "Start Programs/ Accessories/ System Tools/ Disk Cleanup". Select the C drive and check 
the categories that contain unneeded files  
 

Directions For Installing Kavoom! KM  Kavoom! KM combines the keyboard and mouse for two 
computers. Kavoom! KVM would also combine the monitor.   Caution  Be careful not to use or disturb the 
network that is doing communications between the scope and its computer. Use “Start->Run->cmd” to open 
a command line interface and then type “ipconfig" and [enter]. Use ipconfig together with “Network 
Connections” in the Control Panel to figure out which port is doing what. Any hub or switch you use will be 
outside the computer. Sometimes the scope's computer will have a row of Ethernet looking ports in the back 
that looks like it might be a hub, but it is not a hub in the normal sense, and plugging into it could cause 
problems.  

 Create A Network The Kavoom! network will need an Ethernet port on each computer. A single port can be 
used for two networks if it is split with a hub or a switch. An Ethernet card can be added if needed, or a USB 
to Ethernet adapter (available from newegg.com or trendnet.com). 

 
 
 
 Unless using a hub or switch the network cable will be a crossover cable (NOT straight Ethernet). The 
network we create will be minimum duty, without file sharing between the computers. This facil itates safety if 
either computer is connected to an outside network. The protocol for the network is TCP/IP, which will 
probably be there automatically when the network is created.  Kavoom! works best with assigned I.P. 
addresses on each computer. A convenient pair of addresses is 172.17.41.1 (scope side) and 172.17.41.2 
(AMT side). If the network includes another camera just increment the last digit for its address. Both should 
have a subnet mask of 255.255.0.0. To assign addresses right click the network’s icon and click “Properties”. 
Then highlight “Internet Protocol” and click “Properties”.  After you have set-up the cables and assigned I.P. 
addresses the computers should be able to “see” each other via Network Neighborhood. If you are not sure 
you have a good connection, try “pinging” over the new network. Get a command line interface by clicking 
"Start -> Run" and typing in "cmd", then type “ping” [space] and the I.P. address of the other computer and 
[Enter]. If the ping does not get positive results you may have to restart one or both of the computers. You 
may also have to turn off Windows Firewall on one or both computers. Access its on/off switch in the 
Windows Control Panel.   Install Kavoom! If your AMT computer is on the internet, you can download the 
Kavoom! KM software from the Kavoom! Website www.kavoom.biz. Kavoom! gives a 30 day free trial, and 
you can the license the program via the Internet. If you do not have internet in the lab use the Kavoom! 
Corporate edition, which you can get from AMT or by downloading from 
http://www.kavoom.biz/k0000/KaVoomKM3.22Corporate_Setup.exe. If you use the corporate edition you will 
have to get the activation code from AMT, and the AMT computer should be named amt1 (case not 
important).  Run the Kavoom! installer on both computers. Open the Kavoom! program on both. Click 
“Change” to start the configuration process. It will ask you how the monitors are arranged. Hopefully the 
computer’s Kavoom! programs will see the other computer for configuring. If not, you may have to turn off 
Windows Firewall on one or both computers. If you want Windows Firewall on, because you will be 
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connecting to an outside network which may not have a good firewall, you may be able to make an 
exception in Windows Firewall to allow Kavoom!.  Other Notes Usually both keyboards and mice are left 
installed in case either computer is used alone, but one set can be tucked away out of sight.  When either 
computer is restarted Kavoom! should restart automatically. If it does not, open the program from "Start-
>Programs" and click “change” to get the connection started. A problem starting automatically often means 
Windows Firewall is blocking the program. 

Networking    

For many labs, the AMT computer is used without networking. Each user downloads their 
images onto a CD or a flash drive. Ideally, even a non-networked computer should have an 
antivirus utility if there's a lot of users. That decision depends on what priority you place on the 

data stored on the computer. Any computer that does get networked needs an antivirus utility, 
unless it's on a super secure network.   

Bare Bones Networking  

For those AMT computers that do get networked, for file sharing and/or for Internet, there are a 
few precautions. First, AMT is most compatible with "Bare Bones Networking". This kind of 

network give the I.T. Department enough control so they can, for instance, upgrade the 
virusware and run Windows updates from a central location, but less options for remote 
control than is common in some labs. "Zen Masters" and similar utilities for complete remote 

control are ruled out. When networking is done there should still be only one Display Adapter 
visible in the computer's Device Manager (right click "My Computer" and choose 
"Properties", then "Hardware" and "Device Manager".   

Frames Per Second  

There is convenient way to at least partially monitor the effect of networking software. Before 

the process of creating a network begins, do a check on the frames per second (fps) at which 
your camera runs.  This number is given at the lower right part of your AMT display, above the 
buttons for "Set/Save" and "Recall". Check what the rate is for Survey mode and Focus mode 

imaging, and make a record of it. When networking is finished the fps should be the same as 
before networking. If networking slows down AMT it will affect image quality. If that happens a 
lighter network protocol needs to be adopted.   

Saving To A Network  

If you plan to save images to a network drive make sure the drive is write enabled. The 

account of any user that saves images must be set to have full access on the drive's 
"Properties -> Security" tab. If the Security tab isn't displayed deselect "Use Simple File 
Sharing" in Windows Explorer's "Tools - Folder Options -> View" tab.  
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********************************************************************** 
Software 
 
This chapter is intended to help with first time installations as well as upgrades, moving and troubleshooting. 
Most of the software needed can be downloaded from AMT's web site for free.  Please contact us before 
upgrading software for advice and for sign-on information.  Our phone number is 978-774-5550 or email  us 
at info@amtimaging.com. 
 
You must have Administrative privileges to install software on your computer. If you do not think you are a 
"computer person" someone here may be able to "walk you through it" on the phone. Another possibility is to 
find an "IT" person or local computer guru to help you. Whoever does the upgrade, whether coached or 
alone, should contact AMT about the specifics first. 
 
It is also possible to send us your computer for new software installation for a nominal labor charge. 
 
Contents 
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********************************************************************** 
 
********************************************************************** 
AMT Software 
 
An upgrade of AMT software often requires an upgrade of camera driver to be in place first. Please contact 
us before upgrading software for advice and for sign-on information.  Our phone number is 978-774-5550 or 
email us at info@amtimaging.com.  You can see which release is available for you system in the page 
"Which AMT Version" . Software updates and camera drivers are posted on www.amtimaging.com.  
 
You must have Administrative privileges to install software on your computer.  If the upgrade you install is in 
the same release (the version numbers have the same first three digits) as your current version, upgrading 
should be very simple. If you are upgrading to a newer release it is a little more complicated. 
 
It is also possible to send us your computer for new software installation for a nominal labor charge. 
 
The AMT Image Capture Engine, and the other drivers we distribute, are designed to run on computers with 
Windows XP or Windows 2000 as an Operating System. 
 

********************************************************************** 



 98 

Which AMT Version? 
 
Version 600 or 5.4.2 
The Table below describes the combinations of cameras and boards that are supported by AMT600. If your 
system uses one of the board/camera combinations that shows “N”, your upgrade should be to AMT version 
5.4.2.544q ("AMT's Final Release Advantage Plus").  It the camera is supported by AMT600 the download 
link is "Latest Release All XRs, AMT 16000s, AdvHRs, v600...". Both versions are available on the AMT web 
site www.amtimaging.com, after clicking on "Support" and then "Click Here To Start Downloading". 
Contact AMT for the password. 
 

 
 
 
 

Identifying The Hardware 
 
Identifying the Camera Head 
The camera model is written on the camera head. Normally it is printed on the label with the serial number. 
If you cannot find, this call AMT for assistance. 
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Identifying the Frame Grabber Board 
a) The following cameras have only one choice for frame grabber board, so further research is not needed. 
 
Optronics MacroFire 
DVC1412 
Hamamatsu GO4 
Hamamatsu ERG 
Redlake EC11000 
Redlake EC16000 
Kodak Megaplus 4.0 
 
b) These cameras have two or more board options: 
 
DVC4000 
Hamamatsu NR 
Hamamatsu ER 
Hamamatsu ORCAHR 
 
If you have a working version of AMT software, you can identify the board using Windows' Device Manager. 
For the Hamamatsu Cameras: PCDIG and ICPCI boards can be identified under "Sound, Video and Game 
Controllers", while the Active Silicon board shows up under "Imaging Devices". 
For DVC4000: The EDT board will show up in the Device Manager under its own heading and the GigE 
board will show up under the PRO/1000 Grabber Devices heading. 
 
In all cases you can identify the board by visually examining the board itself. 
 
 

Backup Information First 
 
Save AMTCommon 
The data stored on your computer in the folder C:\AMTCommon contains the settings and configurations for 
your camera. Whether you are upgrading a system on the current computer or moving it to a new computer 
having the old AMTCommon can save hours of work. If the new software will go on the current computer 
back up AMTCommon by copying it and pasting it to the C drive, creating a "Copy of AMTCommon" folder. 
If moving to a different computer, download the Copy of AMTCommon to a flash drive or a CD. If you will be 
upgrading to the 600 release from and earlier version, renaming the copy  to "Copy of AMTCommon542" for 
instance, will help keep things clear. 
 
Writing Down Info 

 
If you are upgrading to the 600 release from an earlier one, or if you are upgrading to release 542 from a 
version before that, you can save time by making a written record of some of your parameters before making 
a change.  
 It is always a good idea to record the AMT version number. On the upper menu click "About" and then 

"Version". Write down all the information that gets displayed. This often will inc lude X and Y pixel 
dimensions. 

 Find the Align Offsets by clicking "Utilities" on the upper menu, then click "Camera and Optics 
Adjustments" and finally "Align Camera Center". When the horizontal and vertical centering 
controls appear, write down and record the numbers they contain (don't change anything, just click 
"OK"). 
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 Write down the Exposure Times and Gains for the various sets of settings. Click "Recall" on the lower right 

part of the AMT display and view the various Settings that have been created. One by one click on 
each of them (including the DefaultSettings) and open them by clicking the "Set/Save" button to 
open the Camera Settings Control Window. For each set of Settings write down exposure times, 
gains and record integrations, to transcribe into the new install. 

 

 
 
 In systems with TEM communications it is often useful to have written down which communications 

protocol is selected. To find that, on the upper menu click "Utilities" and the click "Special Options 
- TEM Communications". 

 

 
 
Broken Computer 
If the computer with AMTCommon is not working, you may still be able to salvage AMTCommon. Ask the I.T. 
Department, or local computer guru to remove the hard drive and read it on a different computer. 
 
Fresh Install 
If you are installing AMT for the first time in this lab you obviously don't have anything to back up. The 
settings will have to be done from scratch. 
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Installation AMT And Start Camera 
 
Download and Unzip Software 
After a camera driver version and an AMT version are selected (call AMT for help with this), and after your 
configuration information is backed up, you are ready to download and install the AMT software. It is 
available on the website www.amtimaging.com. The links to downloads are "Support" on the top of the 
home page, and "Click Here To Start Downloading" on the support page. Contact AMT for sign-on 
information. The upgrade to the 600 release is labeled "Latest Software Release All XRs, AMT16000s, 
AdvHRs, v600...". The upgrade to the latest 542 version is labeled "AMT's Final Release AdvantagePlus 
v542544.....". Since the installation files have been zipped with WinZip, you should use WinZip to unzip 
them. WinZip has a free downloadable evaluation version available at www.winzip.com. 
 
Camera's Configuration Folder 
The Configuration folder is the specific folder, within AMTCommon, where cameras settings are stored. In 
AMT versions within the 600 release, the folder name is ConfigCam1 (for the first or only camera) or 
ConfigCam2 (for the second camera). In earlier releases the configuration folder name is Config (for the first 
camera) and ConfigB (for the second one).  
 
Run the Install 
If you have a working version of AMT that starts with 542 or 600, leave it in place (don't uninstall). You might 
use the old version for diagnosis. When the new version is working just delete the links to the old one on the 
Desktop and in the Programs menu. If your version is older than the 542 release call AMT to see if you 
should uninstall it before proceeding. If you are upgrading from a 600 version to a more recent 600 version, 
look first in the configuration for the file "Mags4.txt". Make sure the lines in this file have comma 
separations instead of tabs. If it is delineated by tabs change them to commas and save. In the AMT 
installation folder double click on "Setup.exe". If the file suffixes are hidden, the executable is the "Setup" 
file with an icon that contains a computer monitor. Click "OK" or "Run" for any warnings about an 
"Unknown Publisher". Accept all the defaults during the installation, just click "Next" and "Finish". This 
will be a "Typical" setup. 
 
Run AMT 
If this is a fresh install, or an upgrade to version 600 you will be asked a couple of questions when you start 
AMT. On most modern computers you can say "Yes" to Direct Draw (DirectX). If there's problems with 
imaging you can then turn DirectX off for a test. The purpose of DirectX is to speed up the program. The 
second question will be "Is this system sharing a computer with an H7650". Unless AMT is installed on the 
same computer that is running that kind of scope, the answer is "NO". If you give the wrong answer to either 
of these questions, you can re-answer them by going to the primary configuration folder, (Config or 
ConfigCam1) and deleting the file "DirectDraw.txt" or "UseLeadTools.txt" respectively, and reopening 
AMT. 
 
Click "OK" to warnings about  Darkfield Corrections and Calibrations. Those comes later. 
 
For fresh installs and upgrades to the 600 release, AMT is now ready to run in "Null Camera" mode. Having 
no camera selected, AMT will show a test pattern consisting of a series of vertical lines delineating 
gradations in grayscale, which change spacing and progress from dark to light. If you can not make AMT run 
in null mode there is a problem with the installation. Call AMT for support. If there is a conflict you may 
have to uninstall all versions of AMT and start over. 
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If this install is an upgrade within a release (first three digits of version number are the same), and if the 
install was done with the old AMTCommon in place on the C drive, then your old setting should have been 
incorporated, and for most systems your upgrade should be complete and ready to use. For some systems an 
upgrade of communications software may also be needed (See the "Communications" subchapter). In the 
meantime you can run your camera with communications turned off. Use the menu item "Utilities -> 
Special Options - TEM Communications" to set communications to "None Of The Above" (after making a 
note of which communications had been selected). 
 

 
 
 
 
 
Select Camera 
If your system has two cameras skip this paragraph and go to the page "Two Cameras". When your new 
system is working in NULL Camera mode, you can select a camera by clicking on "Utilities" on the upper 
menu and then "Select Camera". If you don't already know which camera and frame grabber board you 
have, look in the configuration folder inside the saved Copy Of AMTCommon .  Camera and board 
information are in the file InitialXXX.txt, where XXX is the release number. Categories in that file are in 
brackets, and the option under each category that is not preceded by a pound sign is the one selected. 
After selecting a camera close AMT to implement the new settings, make sure that the camera power supply 
is turned on, and for GigE cameras make sure you have found the camera using DVCco's "GigE Camera 
Finder" program (See "Camera Drivers"). When you reopen AMT and go to live imaging the camera 
should work. If not try turning everything, inc luding the camera's power supply, off for a minute and try again. 
When it works proceed to the "Camera Settings" page. 
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Two Cameras 
 
If cameras are mounted at both the side port and underneath the column, AMT will need to be configured 
for two cameras. If you are doing an upgrade within a release (first three digits of the version number are the 
same) and if you run the upgrade with the old AMTcommon in place on the C drive, then the two camera 
configuration, and other settings, from the old software should be integrated into the new software without 
problems. If that doesn't happen, or if you are doing a fresh install, or an upgrade to the 600 release, you will 
need to configure the two cameras manually. 
 
Camera Locations 
The configuration folders are inside the folder C:\AMTCommon. For AMT software with version numbers that 
start with "600", the first opening camera's configuration is in ConfigCam1, and the second opening 
camera's configuration is in ConfigCam2. For all other versions, the first camera is in Config and the second 
one is in ConfigB. 
 
Get One Camera Working First 
As a starting point for this discussion it is assumed that the camera drivers are in place, that AMT is installed, 
and that you are able to run AMT in "Null Camera" mode (no camera selected). It is also assumed that 
cameras' power suppliers are turned on, and that for GigE cameras, you have successfully run DVCco's 
"GigE Camera Finder".  Let's start by selecting one camera to run. This will be the camera that will open 
first when you run AMT (provided you aren't forced to switch the camera's positions during setup). 
Click Utilities" on the upper menu and then click "Select Camera". The Select Camera window will open. 
 

 
 
 
 
If you're not sure which camera you to select, check what the old system was set for in the saved 
"AMTCommon" (now renamed). In the folder Copy Of AMTCommon\ConfigCam1 (or for release 542, 
"Config"), open the file initialXXX.txt, where  XXX is the release number. That file should show the camera 
and board selections as the choices that are not preceded by a number sign in the list. 
Select your camera in the upper drop down box, and select its position in the lower box.  Click "OK" and 
select "Yes" for "Exit Program To Activate New Settings?".  When you reopen AMT and "Click For Live 
Image" the camera should work. You can usually see this without needing a beam on in the scope. If a 
problem shows up during this step call AMT for support. 
 
Set For Two Cameras 
After you have one camera working, open the folder C:\AMTCommon and then open the folder ConfigCam1 
(or Config, in AMT release 542). In there open the file _NumberOfCameras.txt. Change the uncommented 
number from "1" to "2", save the file and close it. Next open _Cam1Properties.txt just to look at it. This will 
be set to "1" on new software. Close the file without changing it, and open _Cam2Properties.txt. If your 
second camera will be the same kind of camera as the one you have working, set Cam2Properties to "2". 
This indicates that the other camera will be the second one of that kind. For all other camera types make 
Cam2Properties "1". Now close all files and run AMT. When the first camera opens It will be labeled as 
"SideMount". Don't worry if that is not correct. You can switch labels later. Hopefully the first camera is still 
working as before. If not you can try changing the _cam2Properties number, and then try switching the 
_Cam1Properties and _Cam2Properties numbers. If neither of those makes it work change _Cam1 and 
_Cam2 properties back where you originally set them, and try selecting the other camera as the first opening 
camera. Sometimes the program will only accept the cameras in its own desired order. 
When one camera is working, with _NumberOfCameras set to two, you can navigate to the second camera. 
Always navigate between cameras by selecting that menu item on the top menu. This makes for the least 
problems. 
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When the second AMT camera display (not necessarily the Bottom Mount) is opened, select the second 
camera in "Utilities". Exit the second camera to activate settings and then open it again. Now the second 
camera should run. If not, try changing the _Cam2Properties number (from 1 to 2 or visa versa), or switching 
the Cam1 and Cam2 properties numbers. If it still won't work you might be forced to set both cameras to 
NULL (no camera) and begin again by selecting your second camera as the first camera to open. When you 
are done, if you have two of the same camera, _Cam1Properties and _Cam2Properties should be 1 and 2 
or visa versa. And if you have two different cameras the numbers should be 1 and 1. 
 
Switch Labels 
If the first camera to open is the bottom mount, both cameras will have the wrong label. To switch labels 
open the file C:\AMTCommon\(ConfigCam1 or Config)\SwitchCameraLabels.txt and change the order of 
the labels. 
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Camera Settings 
 
Now that you have your camera(s) working, they need settings for X and Y Limits Align Offsets, Exposure 
Times and Gains, besides Calibrations (which are discussed on the next page). If this has been an upgrade 
within a release (first 3 digits of the version number the same), and if you ran the install with the old 
AMTCommon in place on the C drive, then all your old settings have been incorporated into the new 
software and the new system is ready to use (In some cases the scope's computer also needs a 
communication driver update. See "Communications".) For upgrades or fresh installs where you don't 
automatically incorporate the old settings, you need to transcribe into AMT the parameters you saved from 
the old software. These will be in the backup you made, Copy of AMTCommon, and/or in written notes you 
made before upgrading. If you don't have old settings to copy in you will have to set them up manually, 
which we discuss at later on this page. 
 
Camera's Configuration Folder 
The Configuration folder is the specific folder, within AMTCommon, where cameras settings are stored. In 
AMT versions within the 600 release, the folder name is ConfigCam1 (for the first or only camera) or 
ConfigCam2 (for the second camera). In earlier releases the configuration folder name is Config (for the first 
camera) and ConfigB (for the second one). Within the configuration folder will be the Settings folder, which 
contains separate folders for the various sets of settings, including DefaultSettings. These each contain a .txt 
file, which has information about Exposure Times and Gains. For the 600 release this .txt file also contains 
the X and Y Limits. The .bin files in this folder are background and darkfield corrections. 
 
X and Y Limits 
The X and Y Limits are the dimensions, in pixels, of your active CCD area. Your written notes from "About -> 
Version" from your old installation may contain these limit numbers. Otherwise look in the AMTCommon 
backup from the old software. If the former installation was release 600, look in the old configuration folder, 
in the Settings folder. Find the DefaultSettings folder and inside there, the file DefaultSettings.txt. The 
Record Width is the X-Limit and Record Height is the Y-Limit. If the earlier version was prior to release 600 
(e.g. 5.4.2) look in the configuration folder for the file InitialXXX.txt, where XXX is the release number. In 
that text file the X and Y Limits are listed. (Ignore InitialDefault...txt files.) 
Once you have the X and Y limit numbers, enter them into the new installation. If you do not have any 
record of the X and Y limits, see "Creating Settings Manually" below. 
 
Entering Saved X and Y Limits Into Release 600 
For release 600, open the AMT software and click the "Set/Save" button on the lower right of the window. At 
the top of the Camera Settings Control window click "Change Camera Format" to open Camera Mode 
Configurator. 
 

 
 
The top box in the Configurator, for the Record Mode, has the horizontal pixels (X Limit) and vertical pixels 
(Y Limit). Set those values to the ones you have recorded from the previous software. You can ignore the 
other numbers in this window. 
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When done click "Accept", and then in the Camera Settings Control window click "Save and Apply 
Conditions To File" and save the changed settings as the Default Settings. Any new sets of settings you 
create, using the DefaultSettings as a starting point, will have the correct X and Y limits. 
 
Entering X Saved and Y Limits Into AMT Release 542 
In AMT 542 release, X and Y Limits are entered directly into the file Initial540.txt (in the configuration 
folder).  
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Enter the correct value under the delineator and save and close the file. The value will be used for all sets 
of settings. 
 
Align Offsets 
Align Offsets electronically move the selected area of the CCD chip, right or left, or up or down, on the 
available CCD pixels. If you are using the entire chip then there is no room to move, and changing the Align 
Offsets will do nothing. The purpose of Align Offsets is to help you perfectly center the camera, so that you 
can use the maximum possible selected CCD area, within the fixed aperture shadows of your scope. 
Adjustments to Align Offsets are made by clicking "Utilities" on the top AMT menu, then "Camera and 
Optics Adjustments" and "Align Camera Center". 
 

 
 

 
 
Entering Saved Align Offsets 
Obtain the Align Offsets numbers from the notes you took before upgrade, or from the old AMTCommon. The 
numbers are stored in a camera's configuration folder in a file called AlignOffsets.txt (pre 600 releases) or 
AlignOffsets2.txt (600 release). Adjustments are done in units of 32 pixels, so a horizontal adjustment of "2", 
and a vertical adjustment of "-1" in the Centering Control will be saved in the Align Offsets file as "64, -32". 
 

 
 
The best way to enter the numbers in the new software is to use the Center Control shown above (entering "1" 
for a 32 in the AlignOffsets file). Alternately the align offsets file can be copied into the new AMTcommon 
(making sure to rename it "AlignOffsets2.txt" first if the new software is in release 600). 
 
Exposure Times and Gains 
Exposure Times and Gains control the camera's speed and sensitivity. The DefaultSettings are what the 
program opens with, and in some labs it is all they every use. Other settings trade in speed for more 
sensitivity, for instance at high mags, or are used to store separate backgrounds. If you wrote down the 
exposure times and gains from the pre-upgrade system enter them in the new software. If you do not have a 
written record, get the exposure times and gains from your backup Copy of AMTCommon. In the camera's 
configuration folder, look in each folder that is inside the Settings folder. Each one will have a .txt file 
which has the exposure times and gains for each of the imaging modes, for that set of settings. Write down 
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the values for each set. 
 
Entering Exposure Times and Gains 
you can now copy the numbers into the appropriate windows in the DefaultSettings, after clicking the 
"Set/Save" button. When done click "Save And Apply Conditions To File" and save as "Default Settings".  
Click "Set/Save" again and enter the numbers for the next set of settings, which you can then save with that 
name. Repeat until all the sets of settings are copied in. After copying in settings from a previous installation 
it is usually a good idea to check them for balance, as described in this manual's chapter "Camera Settings 
And Control Window -> Exposure Times And Gains". 
 
Doing Settings Manually 
This section of for installers who do not have backup information for one or more of the settings parameters, 
either because it was lost, or because this is a fresh installation. 
 X and Y Limits: To see how big you can set the limits in each direction set the scope mag to 12KX (or 

nearby). Turn the camera's background corrections off and retract the sample. Click the "Set/Save" 
button and manually set the Black and White Thresholds to "0", and click "Apply For Now Only". 
Now when you go to live imaging it will be easy to see the limits imposed on the corners by the fixed 
apertures. Remove the objective aperture so that doesn't confuse you. If you see a corner that might 
be the condenser aperture, tweak its centering to make sure that is not what the corner is. Now set the 
limits large, possibly use the whole CCD (see "Entering Saved X and Y Limits" above).  You can see 
where the edges are and about how much you will have to crop. Figure it out by trial and error. Make 
reductions in the X and Y Limits in increments of multiples of 32. When you get all the constrained 
edges out of the picture save that as your Limits in the Default Settings (See above). 

 Align Offsets: While Setting your X and Y Limits, you may be able to get a few more pixels out of the CCD 
by shifting things up or down or left or right with this centering tool (See Above). Alternately, you can 
also use align offsets to center the image by plac ing a sample feature at the crosshairs on the AMT 
image (use "Display -> Select Center Cross"), to compare the feature's position to that on the TEM 
viewing screen. After centering you may need to recheck the X and Y Limits. 

 Exposure Times and Gains: To set these up use the directions in this manual's subchapter "Camera 
Settings And Control Window -> Exposure Times And Gains". For a starting place for the 
DefaultSettings use Focus Mode. Set the exposure time for focus mode to 150 and gain to 3. (Set 
gain to 1 for 1K sidemounts.) Use the "Exposure Times And Gains" directions to balance the other 
modes with this focus mode standard. To create MediumMagSettings and/or HighMagSettings, start 
by bumping up the focus mode, and use the directions to balance the others. For 
SuperHighMagSettings, start with the HighMagSettings and bump up Survey and Record modes (you 
can ignore Focus, which won't be used there). 

 
When you have finished transcribing in settings, or creating settings manually, recall each set of setting and 
collect a DarkField ("Corrections -> Acquire A Dark Image"). 
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Saving Calibrations 
 
For calibrating measurement on a newly installed system, see this manual's subchapter "Measurement And 
Calibration -> AMT Measurement -> Calibration". For upgrades and moves, if your measurement calibration 
is not extensive (i.e. has only a Default calibration), if you are unsure of the calibrations' accuracy or if they 
are very old, you should probably do the calibration over from scratch. It is almost as easy, and they should 
be checked once in a while anyway. However if you have a large calibration table that you want to save, or 
don't have the time or equipment right now to redo calibration, you can transcribe the numbers from the 
previous installation into the new configuration folder. If upgrading or moving a system that uses Montaging 
with AutoStage, you will also need to copy in the stage motion calibration files (see below). 
 
As with the other camera settings, if your upgrade is within the 542 release, and if you ran the installer with 
the old AMTCommon in the correct place on the hard drive, then your calibrations are already saved and 
integrated into the new software. If you already have the 600 release, and are upgrading to a more recent 
version of 600, you need to check the formatting of Mags4.txt. In the new versions Mags4 is comma 
separated. If your current file has lines separated by tabs change the tabs to commas, as shown below. 
 
Linear Measurement 
In the 542 release the default calibration is in the file Calib.txt and the table entrees (voltage and mag 
specific calibrations) are in Mags3.txt. In the 600 release these files are replaced by Calib2.txt and 
Mags4.txt respectively. All these files are in the camera's configuration folder, which is described on the 
previous page ("Camera Settings"). If your upgrade is within release 542 you can copy these calibration files 
directly from your saved "Copy of AMTCommon" from the old software into the new AMTCommon. If the 
upgrade is from a 600 version to a more recent 600 version, the numbers can also be copied in without 
change, but make sure Mags4.txt is comma delineated as shown below. However if the change has been to 
release 600 from 542 or earlier, then the calibration files have to be renamed and refactored, besides 
making the file comma delineated, before being imported. 
Transcribing Calib.txt to Calib2.txt 
To import the default calibration from an earlier release into AMT600, first make a copy of the Calib.txt file 
(copy and paste it in the same folder). Change the name of the copy to Calib2.txt.  The file contains one 
number in quotation marks. That number needs to be made smaller by five orders of magnitude (move the 
decimal point 5 spaces to the left) and then put in scientific notation.  So, if the number you see in Calib.txt 
is " 4257.479", first move the decimal point five places to the left, so the new number is " .04257479". Then 
move the decimal point to the right side of the first non-zero digit, keeping track of how many place it moved 
to get there. The number in scientific notation will be " 4.257479E-2", which means "4.257479 times 10 to 
the minus 2". E and a minus number means you would have to move the decimal point to the left to get the 
number back to it's non for scientific notation status. E and a positive number means you would have to 
move it to the right. When you have the changed and reformatted number in Calib2.txt, you can copy that 
file into the camera's new configuration folder to be the default calibration. 

 
 
 
 
Transcribing Mags3.txt to Mags4.txt 
For the table entry calibrations the process is very similar. First open your old Mags3.txt file to see if it looks 
reasonable. Each line is supposed to have a voltage, a magnification and a mag factor, with the numbers 
separated by commas or tabs.  If there are many lines with all zeroes, the file is corrupted and cannot be 
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used. Make a copy of Mags3.txt in the same folder and rename it to Mags4.txt. Open Mags4.txt and start by 
making sure the separating units in the lines are commas, not tabs. On each line, wherever you see a tab 
separating numbers, delete it and replace it with a comma. On each line, the rightmost number is the mag 
factor. Reduce each of the mag factors by five orders of magnitude and put them in scientific notation as 
described for Calib2.txt. When Mags4.txt has the correct numbers and formatting it can be copied into the 
cameras new configuration folder. 

 

An Old, Tab Delineated Mags4 
 

 
A Comma Delineated Mags4 

 

Diffraction Measurement 
The files in the camera's old configuration folder that have the Default diffraction calibration and the Table 
Entry diffraction calibrations are DiffCal.txt and CamConst.txt respectively. The format for Diffcal.txt has not 
changed. Therefore that can be copied into the new configuration folder without change, whether the 
upgrade is to the 545 or 600 release. CamConst.txt also does not need any number changes, but make sure 
the file is comma delineated. Then it can also be saved and copied into the new configuration folder. Both 
file names will remain the same. 
 
Stage Motion Calibration 
The state motion calibration files are Rangle0.txt, Rangle2.txt and StageXYcal.txt. These can be copied 
into the new configuration file without change. However it might be helpful to save the new configuration 
folder's originals of these files, with a changed name, for comparison in case adjustments are needed. 
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********************************************************************** 
Camera Drivers 
 
Camera drivers need to be in place before AMT can be used with a camera. An upgrade of AMT software 
often requires that camera drivers be updated also. Before upgrading, contact AMT about which drivers you 
need. 
This subchapter is designed to assist with installing and upgrading the drivers. As with the AMT software, 
most camera drivers are available on the AMT website, www.amtimaging.com. 
 
The drivers AMT distributes are intended to run on computers with Windows XP or Windows 2000 as an 
operating system. If you have W2000 rather than XP mention that when asking about drivers, since it could 
make a difference in the driver version. 
 
Contents 
HamDCAM 
DVC 
ICPCI 
IFC 
Optronics 
EDT 
ActiveDCAM 
 
 

********************************************************************** 
HamDCAM Drivers 
 
Download and Unzip 
Almost all Hamamatsu cameras now use the HamDCAM Drivers, which are labeled as such on the AMT 
Downloads page. After downloading them, unzip the package with WinZip, which has a free trial version 
available on www.WinZip.com. If your operating system is Windows 2000, you may need an earlier version 
than what is posted. 
 
Get A Baseline 
If this is an upgrade to a working system, take a look at Windows' Device Manager to get some starting 
information. If you have "Imaging Devices" on the Manager's top level, look in there for either a camera or 
an Active Silicon board. PC-Dig boards and ICPCI boards show up under "Sound Video and Game 
Controllers". A firewire board is also labeled "1394". Right click the device and click "Properties". See 
what you can find out about the drivers - Hamamatsu versus other, Driver Date and Driver Version. Write down 
what you find. If the system has two similar cameras, find out which one is which in the Device Manager by 
turning one off. This information will help you select the right modules during installation, and will tell you 
when the drivers have been updated. It can also be useful diagnostic information if there's trouble. 
 
Uninstall Obsolete Software 
In Windows' Control Panel, select "Add Remove Programs". Uninstall any Hamamatsu programs and any 
HamDCAM or DCAM programs. Also uninstall any versions of IFC that you see there ("IFC" followed by two or 
three digits). When unistallation is done restart the computer. Do not uninstall hardware in the Device 
Manager. Having hardware installed there will faci li tate updating the drivers. 
 
Install HamDCAM 
During installation, on the "DCAM-API Setup" page, take note of the date of the installer. Run the 
downloaded HamDCAM installer, taking care to select the correct module for your hardware, "IEEE 1394" 
for firewire, "Active Silicon Phoenix" for Phoenix boards and "Coreco IFC Module" for PC-Dig boards.  
When the installation is done restart the computer. Find your device in the Device Manager and check the 
driver. Usually the driver will now be updated and ready to go. If not, right click the device and click on 
"Update Driver". When the Hardware Update Wizard appears, choose "No, Not This Time" for the question 
about contacting Windows. Click "Next" and then choose "Install From A List Or Specific Location". Click 
"Next" and uncheck the box for searching "Removable Media". Check the box that allows browsing. Browse 
to C drive and to the folder "Windows" or "WINNT". Inside that folder go into the location 
"System32\DCAMAPI\Setup" and in there find the folder that matches your hardware. Complete the Wizard. 
Go next to the "AMT Software" subchapter. 
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DVC Drivers 
 
The link to DVC drivers is labeled "XR-41 and DVC Drivers" on the AMT Download page. After downloading 
them, unzip the package with WinZip, which has a free trial version available on www.WinZip.com. DVC 
cameras use a range of framegrabber boards including Gig-E and Firewire (both covered on this page), EDT 
(see the EDT page) and PC-DIG (see IFC). 
 
Firewire Cameras 
If upgrading DVC first find your device in the Device Manager and take some notes about the driver, so you 
can see the change when it is updated. Uninstall the old DVC program first ("Control Panel -> Add Remove 
Programs"). Also delete the DVCco folders from the hard drive. There's one on the top level on the C drive 
and one in C:\Program Files. Leave your device installed in Device Manager. Restart the computer before 
installing the new dvcInstall.exe (the other installers in the package are for GigE only). To start the 
Hardware Wizard find your device in the Device Manager, right click, and click "Update Driver". In the 
Wizard choose “Install From a list or specific location” and on the next screen choose “Don’t search, I 
will choose driver”. The camera should be clearly identifiable in the list. If you don't see it in the list, back 
up one screen and browse to the driver. It will be in the folder C:\DVCco\Drivers. 
 
GigE Cameras 
lf your DVC camera uses an Ethernet connection to transfer image data then it is GigE ("Gigabyte 
Ethernet"). The data path is designed to bypass the operating system, to transfer data faster. Therefore when 
it is configured, that Ethernet card will not show us as a Network Adapter in the Device Manager. Rather it 
will appear under the category "Pro 1000/Grabber Devices". All of AMT's GigE installations use the Intel 
Pro1000 adapter, so that the fastest iPORT drivers can be used. 
 
Upgrading An Existing GigE Driver 
Find your Pro 1000 device in the Device Manager and take notes about the driver version and date, so you 
can tell when it is updated. Leave that device in place. In "Add/Remove Programs" uninstall the DVC 
software. Also uninstall the iPORT program. Delete the two folders named "DVCco". One is on the top level 
on the C drive, and one is in the Program Files folder. Restart the computer and run the new dvcInstall.exe. 
Also run the iPORT_IPEngineSDK installer.  During the installation of iPORT select the "Runtime" type. If 
the device becomes uninstalled in the Device Manager see the directions for Installing a new GigE device. 
Now proceed to "GigE Driver Update". 
 
Installing a new GigE Device 
First look in the Device Manager at what Network Adapters are already in place, so you know which one is 
the new one. Power off and unplug the computer and install the Gigabit Ethernet card. Touch the computer 
chassis first to discharge static electricity. On restarting, if the Hardware Installation Wizard appears, allow it 
to automatically install the card's drivers. You will change them later. Run the new dvcInstall.exe and then 
the iPORT_IPEngineSDK installer. During the installation of iPORT select the "Runtime" type.  If the new 
card does not appear in the Device Manager, run the installer PRO2KXP.exe, which is in the package you 
unzipped. This should install the card as a Network Adapter. In rare cases it has been necessary to 
temporarily disable the onboard Network Adapter during GigE installation (using the computer's BIOS), to get 
the new card installed. Now proceed to "GigE Driver Update".  
 
GigE Driver Update 
Once your card and your software are installed, click on "Start -> All Programs". In the Programs menu find 
the category "Pleora Technologies Inc" and select "eBUS Software -> Ethernet Bus Driver Tool". 

  
 
 
This will open the Driver Installation Tool window. In the upper window select the Network Adapter used for 
the camera. Then cl ick "Configure". 
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This will bring up the Network Adapter Configuration Wizard. Choose the iPORT Family Of Drivers. Then 
cl ick "Next". 

 
 
In the Wizard's next window choose "iPORT High-Performance IP Device Driver".  
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Click "Finish" to continue. 
In the Driver Installation Tool window click "Update Drivers". This will open the Update Drivers window. 

 
 
 
If the iPORT High-Performance Driver's "Installed version" does not match it's "Available Version", click that 
row's "Update" button. Close the window. The computer will now need to be restarted. After restart open the 
Driver Installation Tool again to confirm that the drivers are updated. Look in the Device Manager to make 
sure that the Pro 1000 Grabber Devices is installed and functional. 
 
Cable Up and Power On Camera 
After cabling up the camera switch on its power supply. After about a minute both LEDs on the camera 
should light up as green, and one should be flashing on and off about once a second. An amber color 
means the connection does not support a gigabit transfer rate. 
 
"Find" The Camera, To Fix Its Address 
To fix the camera's address run the program "Start -> All Programs  -> DVCco -> GigE Camera Finder". 
This only needs to be done the first time you run the camera. The address fix is stored in one of the DVCco 
folders on the hard drive. Check that the first three numbers of the Camera IP match those of the Adapter IP. 
If necessary change the Camera IP and click "Reset IP". 

 
 
The camera is now ready to work with AMT. It will also work with DVCView (for diagnostic purposes). 
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ICPCI Drivers (ITEX41) 
 
The ITEX41 package of drivers is for all cameras that use an ICPCI board as a frame grabber. These are the 
only drivers that those cameras need. The ITEX41 Drivers are posted on AMT's download page. After 
downloading them, unzip the package with WinZip, which has a free trial version available on 
www.WinZip.com. 
 
Avoid Generic Drivers 
If you find that your ICPCI board is installed in the Device Manager, automatically or otherwise, before the 
ITEX drivers or its patches are installed, then the board has the wrong drivers. Make a note of the driver's 
name and location, and then use the Device Manager uninstall the board. Find the generic drivers and 
rename them, so they don't interfere. 
 
Install ITEX 
Run the ITEX installer, and select "ICPCI Board". Other than that selection, accept the defaults during 
installation. 
 
Copy In Patches 
For ITEX to work properly on Windows 2000 and Windows XP there are two files that have to copied onto 
the computer's hard drive. There are separate versions for the two operating systems, so be sure you have the 
right one. They are both located in the package that you unzipped. You will copy these files into folders 
within the Windows folder. If these folders already contain files with the same name, rename them to keep 
them separate.  
 
itipci2k.inf       Should be copied into the folder   C:\Windows\Inf 
mvcntp.sys     Should be copied into the folder   C:\Windows\System32\Drivers 
Install the board 
In the Hardware Installation Wizard choose "Install the Software Automatically". 
 

  IFC Drivers 
 
Download and Unzip 
A few of the cameras with PC-DIG boards cannot use the HamDCAM drivers and must use IFC instead. These 
inc lude AdvantagePlus (KodakES4.0) and certain DVC cameras. Use the latest version, IFC5.10, which is 
labeled as such on the AMT Downloads page (www.amtimaging.com -> Support -> Click Here To Start 
Downloading). After downloading, unzip the package with WinZip, which has a free trial version available 
on www.WinZip.com. 
 
Get A Baseline 
If this is an upgrade to a working system, take a look at Windows' Device Manager to get some starting 
information. PC-DIG boards show up under "Sound Video and Game Controllers". See what you can find 
out about the drivers - Driver Supplier, Driver Date and Driver Version. Write down what you find. If the system 
has two similar cameras, find out which one is which in the Device Manager by turning one off. This 
information will help you select the right modules during installation, and will tell you when the drivers have 
been updated. It can also be useful diagnostic information if there's trouble. 
 
Switch Off Power to The Camera 
Turn it back on after the new board drivers are in place. 
 
Uninstall Obsolete Software 
In Windows' Control Panel, select "Add Remove Programs". Uninstall any old IFC programs ("IFC" followed 
by two or three digits). When unistallation is done restart the computer. Do not uninstall hardware in the 
Device Manager. 
 
Install IFC5.10 
Run Setup.exe in the IFC510 package. Click "Run" if given a warning about an "Unknown Publisher". The 
installer will present a page to "Select Components". PC-DIG is the only one that needs to be selected. 
Reboot the computer. 
 
Install The Device Drivers 
Find your device in the Device Manager, right click and select "Update Driver". When the Hardware 
Update Wizard appears, choose "No, Not This Time" for the question about contacting Windows. Click 
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"Next" and then choose "Install From A List Or Specific Location". Click "Next" and in the next window 
choose "Don't search. I will choose the driver to install". Click "Next". In the next window choose the PC-
DIG device and finish. The process may repeat for the two serial ports connected with the PC-DIG board. 
There is more detailed driver installation notes available in "Programs -> IFC 5.10 Runtime -> Release 
Notes". The notes file is "IFC510_00.doc", which is in C:\IFCRuntime and is also on the CD . 
 

Optronics Drivers 
 
The Optronics camera is also known as the "XR-40". The XR-40 Drivers program (named "PictureFrame"), 
is posted on the AMT download page. After downloading them, unzip the package with WinZip, which has a 
free trial version available on www.WinZip.com. 
 
Check For Upgrade Version 
If upgrading the Image Capture Engine, contact AMT to see if you also need an upgrade of PictureFrame.  
 
Install PictureFrame 
First go to "Add/Remove Programs" in the Control Panel and uninstall the old PictureFrame version. Leave 
the device installed in the Device Manager. Restart the computer and install PictureFrame. 
 
Install The Camera 
Find your device the Device Manager and click “Update Driver”. In the Wizard choose “Install From a list 
or specific location” and on the next screen choose “Don’t search, I will choose driver”. The camera 
should be clearly identifiable in the list. If you don't see it in the list, back up one screen and browse to the 
driver. The main part of its name will be “MacroFire” and it should be in the folder “System32” in 
“Windows” or “WINNT”. 
 
 

EDT Drivers 
 
Use these drivers for cameras that use the EDT CamLink Board. Currently this includes AMT 16000 
PIACON/Redlake Cameras, TR111, TR160, TLD111, TLD160 and some DVC cameras. These have gone 
through many changes, so be sure to check with AMT to make sure you have the correct one for your 
camera. For DVC cameras download the"XR-41 and DVC Drivers" from the AMT Download page. This 
installation then has a link to the EDT drivers which are also needed.  For the other cameras use the EDT CD 
supplied by AMT.  
 
Installation Procedure 
 
Caution: 
After installation the EDT cable MUST plug into Port #1 on the EDT Framegrabber board. 
Be sure that the cable in plugged in and then secured with the screws.  Do not use the screws to pull the 
plugs into place - this often results in a poor connection.  For bottom mounts, leave the cables wrapped 
around the camera head and held there with a cable tie. 

 
1.Uninstall old versions of both DVC and EDT software. Delete the folder "DVCco" from both the "C-

drive" and the "Programs Files" folder. 
2.If the board is not installed yet, leave that out until the software is installed. If it is installed, find it 

in the "Device Manager". It will appear under "System devices". Record what information you 
can about the driver (date, version, etc.) to help you know when you've updated it. 

3.For DVC Cameras: Run the DVC software installer. Then in the folder 
"C:\DVCco\Drivers\CameraLink" find the link to the EDT driver installer and download it. If this 
PC is not networked you can paste this url in the browser on another computer - 
"http://www.dvcco.com/software/drivers/cameralink/windows/EDTpdv.exe". When you hit 
"Enter" a download screen will appear behind the browser. After EDTpdv.exe is downloaded, 
install it on the camera computer. Ignore the warning about "Unknown Publisher". 

4. For All Other Cameras: Insert the EDT CD and run Winsetup.bat.  Ignore the warning about 
"Unknown Publisher". Select "PCI DV" and accept the defaults.   
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5.Now install the board and start the computer. If the board is already installed at this point, find the 

device in the "Device Manager" and uninstall it. Then restart the computer. The Hardware 
Installation Wizard will appear. 

6.In the Wizard click "No" for contacting Windows. In the next screen choose "Install from a list or 
specific location" and in the next window choose "Search". Browse to "C:\edt\pdv". The 
Wizard is looking for the file pdv2k.sys. Finish the Wizard. 

7.Check in the Device Manager to make sure it sees the EDT Pdv c-link board. Cable up the camera 
and turn on its power. On RedLake cameras, the power light will turn green, the status light will 
flash green and the data lights will turn green. On the DVC's with LEDs, both will turn solid green 
and then one will start to flash on and off. 

8.You are now ready to configure the AMT software. 

 
 
 
 

ActiveDCAM Drivers 
 
USE 
The XR-42 camera uses ActiveDCAM drivers and a FirewireB board.  
 
Documentation 
Detailed installation instructions are available from AMT. 
 
Board Speed 
In order for the camera to work properly, the FirewireB board must be set to run and 800 MBPS. For Windows 
XP systems with Service Pack 2 or 3, the Microsoft "Hotfix" mentioned in the instructions is Not required. 
However the "Rollback" of the drivers is necessary. 
 
Resetting Camera 
Since this camera does not have a separate power supply to recycle, resetting the camera is done by 
rebooting the computer. 
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********************************************************************** 
Communications 
 
"Communications" is where the scope's computer tells the AMT computer its mag and KV. This sub chapter 
discusses preserving communications during upgrades and setting up communications for the first time. 
 
 
Contents 
 
AMT Side Configuration 
HyperTerminal 
Scope Side Configuration 
 

********************************************************************** 
 

AMT Side 
 
Basic Configuration 
These directions are for AMT camera's that have their own separate computer. For Integrated systems, or 
systems where the scope and camera share a computer, contact AMT for directions. The first thing to do on 
the AMT side for communications is to make sure the correct ComPort is selected in the software. That 
assignment is made in the camera's configuration folder in the file "SerialTEMPort.txt". Once that is done 
select the communications protocol by clicking "Utilities -> Special Options -> TEM Communications" and 
select your microscope in the window that opens. Restart AMT to incorporate the change. If 
communications doesn't work at that point you can check the connection using "HyperTerminal" (See next 
page). 
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H7650 
If communications is with an H7650 scope, another text file may need to be created and saved to the 
camera's configurations folder. The file is "TEMComSetup.txt" and it specifies the baud rate, parity, data 
bits and stop bits. It sets those parameters on the AMT side to match those used by the scope computer's 
comport. The text that usually appears in the file is "9600, N,8,1" including the quotation marks. On the 
scope's computer, look at the comport setup in the menu "Maintenance\TEM adjustment" to see what 
parameter numbers are being used. 
 
For almost all of the H7650s and the H7600s, the correct choice for communications is the triplet "Hitachi 
External Control H-7500 H-7600 H-7650".  
 
FEI Morgagni, 208 and CM 
To communicate with FEI Morgagnis and 208s, the AMT computer uses another utility called 
"RS232Remote". For CMs the extra utility is "Remote Control Driver". If your AMT upgrade is for one of 
these scopes, contact AMT to see if the communications utility needs to be upgraded. 
 
Incorporating Settings Automatically 
If your upgrade is within a release (first three digits of the version number are the same), and if you run the 
install with AMTCommon in place on your computer's hard drive, then the communications settings are 
preserved and communications will usually resume working at this point. If it doesn't the scope's computer 
may also need a communications software update (See the page "Scope Side"). Check with AMT about 
needed communications package upgrades before upgrading AMT. If you get to this point and 
communications won't work, turn them off temporarily using the window pictured above. You can also use 
"HyperTerminal" to check the connection (See next page). 
 
Transcribing In Settings 
The information you need to configure the AMT software for communications are the TEM Communication 
type and the number of the serial port used for TEM communications. If this information is not in your written 
notes it is in the backup "Copy Of AMTCommon" that you made (and possibly renamed). The TEM 
Communications type usually just goes by the scope name, but there are occasionally exceptions. Look in 
the camera's old configuration folder at the file "InitialXXX.txt" (where XXX is the release number) and find 
the category "[TEMcom]". The option under that heading, without a pound sign in front of it, is the selected 
one. In the same folder look for the file "SerialTEMPort.txt". The number in that file is the number of the 
serial port that the old software used for communications. Transcribe that number into the 
"SerialTEMPort.txt" in the new configuration folder. If you don't have a backup of the serial port number, 
you can see which ports you have, in the Device Manager and try them in order. If you need to confirm a 
connection, you can use "HyperTerminal" (See next page). Cameras on some of the H7650s also have the 
file "TEMComSetup.txt" in their configuration folder. If you find one in the old configuration folder, copy it 
into the new folder. 
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HyperTerminal 
 
Running Windows' "HyperTerminal" accessory on both computers simultaneously allows you to check 
whether a connection is live, and find out which Comports are used.  
 
Setting Up HyperTerminal 
This test requires that no other program is trying to use the specified Comport to communicate, so turn off 
AMT and on the scope side, turn off the user interface to the scope. The path to open the HyperTerminal 
program is "Start -> All Programs -> Accessories -> Communications -> HyperTerminal". 

 
 
 
 When the program opens it will ask about making HyperTerminal a default program, to which you can say 
"No". It will ask for a name for this connection. Anything works. Then you choose which comport to use. If it 
asks for an Area Code, just make one up. Click "OK" to continue. When the "Port Settings" tab comes up 
accept the default values ("2400", "8", "None", "1", and "Hardware"). Just make sure both computers' are 
using the same values. Click "OK" to continue. 
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On the top menu of the HyperTerminal window, click "File -> Properties", and in the window that comes up 
choose the "Settings" tab. On that tab click the "ASCII Setup" button. 

 
 
 
Check all the rows on the ASCII Setup page. Click "OK" to continue. 
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Now, if the computers are connected by the specified ports, text typed into one of the windows will show up 
in both. 

 
 

Scope Side 
 
Communications software on the scope's computer is usually turned on and configured by the scope 
engineer, and is not usually a user function. The two exceptions to that rule are described here. 
 
EXT 1 and EXT 0 
For some JEOL scopes communications are turned on and off by typing "EXT 1" [Enter] and "EXT 0" 
[Enter]  (including the space) respectively, into the scope's input panel. The AMT computer may have been 
doing that for you, but if the sequence gets interrupted, say by a power outage, you will have to manually set 
it to zero. Whether it is done manually or by AMT you can see it being entered on the JEOL monitor. 
 
FEI Tecnai 
The Tecnai is the one scope where AMT regularly adds and does upgrades to a communication program on 
the scope's computer. If doing an upgrade of AMT, contact AMT to see if the scope's "ExtTecnai" program 
need to be upgraded also. As a diagnostic test, you can see if ExtTecnaiG2 is running by looking in that 
computer's "Task Manager". Open by pressing the keyboard's "Ctrl", "Alt" and "Delete" keys. ExtTecnaiG2 
should be running whenever the computer is running. 
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********************************************************************** 
AMT Support  
 
The first section has contact information for applications support and camera repair. The section briefly 
describes software upgrade via website downloads. 
 
    Contents 
 
    Applications Help, Repair and Problem Solving 
    Software Upgrades 
 

********************************************************************** 
Applications Help, Repairs and Problem Solving  
 
Please call at:      Advanced Microscopy Techniques  
                              3 Electronics Avenue  
                              Danvers, MA  01923 USA  
   
Or use our website:   http://www.amtimaging.com for further information.  
  
   
You can reach us in person at (978) 774-5550 or fax us at (978) 739-4313 
   
Our e-mail address is:  info@amtimaging.com  
 
 
 

Upgrading AMT Software  
 
 
Most of the time software updates can be downloaded AMT's website for free.  Please contact us before 
upgrading software for advice and for sign-on information.  Our phone number is 978-774-5550 or email  us 
at info@amtimaging.com. 
 
You must have Administrative privileges to install this software on your computer.  If you are not familiar with 
this or WinZip or  install procedure,  please have your "IT" person or local computer guru contact us.  
 
It is also possible to send us your computer for new software installation for a nominal labor charge. 
 
For more information about upgrading software, see this manual's subchapter "Software -> AMT Software". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 


